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Abstract 

 
 
 

The aim of the present project is the development of an Image Reconstruction 

application, which visualizes images from SPECT data. We reviewed nuclear medical 

imaging, methods of image reconstruction and particularly the SPECT imaging. We 

studied two of the image reconstruction algorithms for SPECT data, MLEM and 

OSEM, and we built a suitable GUI application. At the end, we made some 

performance tests of the final application. 

 For the needs of the project, we converted the original code of the image 

reconstruction algorithms, which were written in C, into C++, which is the language 

that the whole project's application is developed. In addition, we used the C++ toolkit 

Qt for GUI application development, which is the standard framework for developing 

high-performance cross-platform applications. 

 There were two image reconstruction methods developed, the MLEM 

algorithm and the OSEM algorithm. The first one (Maximum Likelihood Expectation 

Maximization) has precise results, but it needs sufficient time to complete the image 

reconstruction file. Whereas, the latter (Ordered Subsets Expectation Maximization)  

has the same base idea with the MLEM algorithm, but its convergence is much more 

faster.  

Finally, the application’s functionality and performance was tested with clinic 

data, which were produced by SPECT/CT camera Varicam of GE Medical from the 

clinic Charite Verichow, Berlin. 
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Περίληψη 
 

 

Αντικείµενο της παρούσης εργασίας είναι η ανάπτυξη µιας εφαρµογής σε 

γραφικό περιβάλλον για την ανακατασκευή εικόνων τοµών  από δεδοµένα 

τοµογραφίας SPECT. Πραγµατοποιήθηκε βιβλιογραφική επισκόπηση της ιατρικής 

απεικόνισης , των µεθόδων τοµογραφικής ανακατασκευής εικόνας και ιδιαίτερα της 

πυρηνικής ιατρικής απεικόνισης. ∆όθηκε έµφαση στους επαναληπτικούς αλγόριθµους 

MLEM και OSEM, για τους οποίους ήταν διαθέσιµη η υλοποίηση τους σε γλώσσα C. 

Μετατρέψαµε τα προγράµµατα αυτών των αλγορίθµων ανακατασκευής σε C++ και 

υλοποιήσαµε τη σύνδεσή τους µε το γραφικό περιβάλλον της εφαρµογής. 

Για την ανάπτυξη της γραφικής διασύνδεσης του χρήστη µε το πρόγραµµα 

χρησιµοποιήθηκε η πλατφόρµα  ανάπτυξης γραφικού περιβάλλοντος σε γλώσσα 

προγραµµατισµού C++, Qt. Το εργαλείο αυτό είναι ιδιαίτερα δηµοφιλές στην 

ανάπτυξη διασύνδεσης χρήστη προγράµµατος και χρησιµοποιείται ευρέως σε 

εφαρµογές ανοικτού αλλά και  κλειστού κώδικα.  

Επίσης υλοποιήσαµε κάποιες απλές λειτουργίες επεξεργασίας των εικόνων 

των τοµών. Αυτές ήταν η δυνατότητα για zoom in, zoom out µιας εικόνας, η 

εισαγωγή χρωµατικής απόχρωσης και η παραγωγή εικόνας  δέκα  χρωµάτων από µια 

µονόχρωµη εικόνα σύµφωνα µε µια συγκεκριµένη παλέτα χρωµάτων.  Το λογισµικό 

δοκιµάστηκε µε  κλινικά δεδοµένα, τα οποία παρήχθησαν από SPECT/CT camera 

Varicam, του οίκου GE Medical από την κλινική Charite Verichow του Βερολίνου. 
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ΚΕΦΑΛΑΙΟ  1  

 

ΕΙΣΑΓΩΓΗ 
 

 

 

1.1 Ιατρική Απεικόνιση 

 

Ο όρος ιατρική απεικόνιση  περιλαµβάνει τις τεχνικές και τις διαδικασίες που 

χρησιµοποιούνται για να παραχθεί µια εικόνα του ανθρώπινου σώµατος ή µέρος 

αυτού για κλινικούς σκοπούς (εξέταση, διάγνωση ή θεραπεία µιας ασθένειας) ή για 

επιστηµονικούς λόγους (µελέτη της ανατοµίας). ∆ιάφορες µορφές ενέργειας 

χρησιµοποιούνται και µελετάται η αλληλεπίδραση αυτών µε τους βιολογικούς ιστούς 

µε στόχο την εξαγωγή  κλινικά χρήσιµης πληροφορίας. Η πληροφορία αυτή 

καταγράφει  σε τοµογραφικούς χάρτες κάποια ιδιότητα των ιστών. 

 Στα αρχικά στάδια, για την απεικόνιση χρησιµοποιήθηκαν οι ακτίνες Χ που 

ανακαλύφθηκαν από τον  (Wilhelm Röntgen) το 1895,  έτσι η εφαρµογή τους στην 

Ιατρική ονοµάστηκε Ακτινολογία, η οποία περιλαµβάνεται σε µια ευρύτερη θεώρηση 

του όρου ιατρική απεικόνιση. Με την πρόοδο της Ιατρικής και της Φυσικής, κυρίως 

τα τελευταία 30 χρόνια, ανακαλύφθηκαν και εφαρµόστηκαν και άλλες µέθοδοι 

απεικόνισης του σώµατος. Με την παρουσίαση του Υπολογιστικού Αξονικού 

Τοµογράφου ( Computed Axial Tomography – CAT )  στα 1972  από τον Hounsfield 

ξεκίνησε µια νέα εποχή για τη σύγχρονη ιατρική απεικόνιση. Μια πλειάδα 

απεικονιστικών συστηµάτων, όπως η απεικόνιση µε χρήση ραδιενεργών πυρήνων, οι 

υπέρηχοι και ο πυρηνικός µαγνητικός συντονισµός, έχουν εξελιχθεί και ενταχθεί στην 

καθηµερινή χρήση της ιατρικής επιστήµης.  

 Σήµερα, η αλµατώδης εξέλιξη στην ψηφιακή τεχνολογία και στην επιστήµη 

της πληροφορικής οδήγησε σε σηµαντικές εξελίξεις στο χώρο της ιατρικής 

απεικόνισης. Η ταχύτατη απόκτηση, επεξεργασία και αποθήκευση µεγάλου όγκου 
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δεδοµένων έδωσε µια νέα ώθηση και προσέφερε νέες δυνατότητες στις τεχνικές 

τοµογραφικής απεικόνισης. Αυτό έχει οδηγήσει στην ανάπτυξη ενός τεράστιου 

πλήθους από ψηφιακές εφαρµογές µε σκοπό την επίλυση ιατρικών προβληµάτων. Η 

ιατρική απεικόνιση έχει µεταβληθεί σε µια  από τις σηµαντικότερες µεθόδους 

οπτικοποίησης και εξαγωγής συµπερασµάτων στη βιολογία και την ιατρική.  Ο 

σχεδιασµός, η ανάπτυξη και ο έλεγχος ολοκληρωµένων συστηµάτων για κλινική 

χρήση απαιτεί τη στενή διεπιστηµονική συνεργασία µεταξύ φυσικών, βιολόγων  και 

µηχανικών.[1] 

 

1.2  Τοµογραφική Απεικόνιση 

 

 Η Τοµογραφία είναι η απεικόνιση τοµών ενός αντικειµένου. Τα δεδοµένα, 

που λαµβάνονται, προέρχονται από τη διάδοση, εκποµπή ή την ανάκλαση 

ακτινοβολίας από το αντικείµενο προς εξέταση σε διαφορετικές διευθύνσεις και στη 

συνέχεια τροφοδοτούν έναν αλγόριθµο τοµογραφικής ανακατασκευής εικόνας σε 

υπολογιστή.  Η επίδραση αυτής της τεχνικής στη διαγνωστική ιατρική ήταν τεράστια, 

αφού έδωσε τη δυνατότητα σε γιατρούς και επιστήµονες να µελετούν εσωτερικά 

όργανα  µε ακρίβεια, που δεν ήταν εφικτή προηγουµένως, και επίσης µε σχετική 

ασφάλεια για τους ασθενείς.    

 Στις πρώτες εφαρµογές της απεικονιστικής τοµογραφίας χρησιµοποιούνταν 

ακτίνες Χ, ωστόσο σήµερα περισσότερα και διαφορετικά φυσικά φαινόµενα 

βρίσκουν εφαρµογή όπως ακτίνες γ, εκποµπές ποζιτρονίου, µαγνητικός συντονισµός 

(MRI), υπέρηχοι  κ.ά.. Τα αντίστοιχα είδη τοµογραφίας είναι CT, SPECT, PET, MRI, 

υπερηχογράφηµα.    

 Η τοµογραφική απεικόνιση σχετίζεται βασικά µε την ανακατασκευή µιας 

εικόνας από τις προβολές της.  Με την αυστηρή έννοια του όρου µια προβολή σε µια 

δοσµένη γωνία είναι το ολοκλήρωµα της εικόνας στην κατεύθυνση που ορίζει η 

γωνία αυτή.  Μια προβολή εκφράζει την εξαγόµενη πληροφορία από την διερχόµενη 

ενέργεια όταν το αντικείµενο  ακτινοβολείται υπό µια συγκεκριµένη γωνία.    

 Πολλοί διαφορετικοί αλγόριθµοι ανακατασκευής εικόνας υπάρχουν και οι 

περισσότεροι από αυτούς κατατάσσονται σε δυο κατηγορίες : φιλτραρισµένη 

οπισθοπροβολή (filtered back projection FBP) και επαναληπτικής ανακατασκευής 
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(iterative reconstruction IR). Οι δυο αυτές οµάδες αλγορίθµων ανακατασκευής 

διαφοροποιούνται όσον αφορά την ακρίβεια των αποτελεσµάτων και τον χρόνο 

υπολογισµού που χρειάζονται. Οι αλγόριθµοι  φιλτραρισµένης οπισθοπροβολής 

έχουν µικρότερες υπολογιστικές απαιτήσεις, ενώ οι επαναληπτικοί αλγόριθµοι 

παράγουν γενικώς λιγότερα λάθη κατά την ανακατασκευή  αλλά µε µεγαλύτερο 

κόστος σε πόρους και χρόνο.  Οι δυο αυτοί τύποι αλγορίθµων θα εξεταστούν 

εκτενέστερα στο επόµενο κεφάλαιο.  [1, 2] 

 

1.2.1 Αρχές Τοµογραφικής Απεικόνισης 
 

 Αν έχουµε ένα αντικείµενο (π.χ. κύβος) σε ένα σύστηµα συντεταγµένων (x, y, 

z) και θέλουµε να απεικονίσουµε µια τοµή του σε ένα επίπεδο κάθετο σε αυτόν, η 

διαδικασία τοµογραφικής απεικόνισης συνίσταται στην περιστροφή ενός ανιχνευτή 

γύρω από το αντικείµενο και στη συλλογή προβολών, από ένα αριθµό γωνιών. Με 

χρήση καταλλήλων αλγορίθµων ανακατασκευάζονται τοµές σε επίπεδα, που είναι 

κάθετα στον άξονα περιστροφής. 

 

                                      (α)                                                    (β)                                                     (γ) 
 

Σχήµα 1.1: (α) Κύβος σε ορθοκανονικό σύστηµα συντεταγµένων. (β) Τοµογραφικό επίπεδο. (γ) Τοµή. 

 

 Η προβολή ενός αντικειµένου σε µια δοσµένη γωνία, θ, κατασκευάζεται από 

ένα σύνολο από γραµµικά ολοκληρώµατα. Στην αξονική τοµογραφία (CT) το 

γραµµικό ολοκλήρωµα αντιπροσωπεύει τη συνολική εξασθένηση της δέσµης ακτίνων 

Χ, καθώς αυτή διέρχεται µέσα από το αντικείµενο, ενώ στην τοµογραφία SPECT την 

εκπεµπόµενη ακτινοβολία, που είναι ανάλογη της συγκέντρωσης ενός 

ραδιοφαρµάκου σε κάποιο ιστό ή σηµείο του σώµατος 

x 

z 
z

x

y y

z 

x



 8

 Ο ευκολότερος και απλούστερος τρόπος οπτικοποίησης µιας περιοχής είναι το 

σύστηµα παράλληλων προβολών, που είχε χρησιµοποιηθεί στους πρώτους 

τοµογράφους. Εδώ, θεωρούµε ότι τα δεδοµένα συλλέγονται από σειρές παράλληλων 

ακτίνων στη θέση r και κατά µήκος µιας προβολής σε γωνία θ, το οποίο 

επαναλαµβάνεται για διαφορετικές γωνίες.  

 
Σχήµα 1.2 : Γεωµετρία παράλληλης δέσµης. Κάθε προβολή δηµιουργείται από ένα σύνολο  από 

ολοκληρώµατα κατά µήκος του αντικειµένου. 
 

Θεωρούµε ένα δισδιάστατο αντικείµενο που παριστάνεται από τη συνάρτηση 

f(x,y) της χωρικής κατανοµής µιας φυσικής ποσότητας (στην τοµογραφία SPECT 

αυτή η φυσική ποσότητα είναι ο αριθµός των εκπεµπόµενων φωτονίων)  και 

εργαζόµαστε στο ορθογώνιο σύστηµα συντεταγµένων (t,s) που έχει στραφεί ως προς 

το σύστηµα (x,y) κατά γωνία φ. Το επικαµπύλιο ολοκλήρωµα της f(x,y) κατά µήκος 

µιας γραµµής L παράλληλης ως προς τον άξονα s, η οποία ονοµάζεται τοµογραφική 

ακτίνα, αποτελεί τα δεδοµένα προβολής (projection data) και ισούται µε:  

P(φ,t)=∫f(x,y)ds. 
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Σχήµα 1.3: Προβολές από διαφορετικές γωνίες συλλέγονται έτσι ώστε να δηµιουργηθούν οι εικόνες 

των τοµών και ίσως µια τρισδιάστατη απεικόνιση.  
 
 

Μια οµάδα δεδοµένων προβολής κατά µήκος παράλληλων γραµµών 

δηµιουργεί µια “όψη”, η οποία είναι ένα µονοδιάστατο προφίλ της µετρούµενης 

ποσότητας σαν συνάρτηση της θέσης και αντιστοιχεί σε µια δεδοµένη γωνία φ. Η 

συλλογή πολλών διαφορετικών όψεων µπορεί να παρασταθεί σ’ ένα δισδιάστατο 

διάγραµµα ή σαν εικόνα, όπου ο ένας άξονας είναι η θέση t και ο άλλος η γωνία φ. Η 

εικόνα αυτή ονοµάζεται ηµιτονόγραµµα (Sinogram) ή µετασχηµατισµός Radon του 

δισδιάστατου αντικειµένου (Radon Transform). Σκοπός των αλγορίθµων 

ανακατασκευής εικόνας είναι η επίλυση του αντίστροφου µετασχηµατισµού Radon 

προκειµένου να προσδιοριστεί η εκτίµηση της προς ανακατασκευή εικόνας f(x,y) 

βάσει των δεδοµένων προβολής.[1-3] 
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1.3  Πυρηνική Ιατρική – SPECT 
 

Η τεχνική της µονοφωτονιακής 

τοµογραφίας εκποµπής (Single Photon 

Emission Computerised Tomography-SPECT) 

είναι µια µέθοδος ιατρικής απεικόνισης που 

συνδυάζει τις συµβατικές τεχνικές απεικόνισης 

της πυρηνικής ιατρικής µε τις µεθόδους 

ανακατασκευής της εικόνας. Στην τοµογραφία 

SPECT χρησιµοποιούνται ακτίνες γ και µπορούµε να απεικονίσουµε λειτουργικές 

πληροφορίες για κάποιο συγκεκριµένο όργανο του ανθρώπινου σώµατος. Η συνεχώς 

αυξανόµενη ποιότητα και ποσοτική ακρίβεια των εικόνων SPECT σε συνδυασµό µε 

το χαµηλό κόστος τους, καθιστούν την τοµογραφία SPECT ως ένα από τα 

χρησιµότερα διαγνωστικά εργαλεία. 

Η διαδικασία της απεικόνισης SPECT αρχίζει µε τη χορήγηση ενός 

ραδιοφαρµάκου στον εξεταζόµενο. Το ραδιοφάρµακο συγκεντρώνεται επιλεκτικά σε 

ορισµένους ιστούς ή όργανα ανάλογα µε τις βιοκινητικές του ιδιότητες και την 

παθοφυσιολογία του ασθενούς. Τα χρησιµοποιούµενα ραδιονουκλίδια εκπέµπουν 

ακτίνες-γ χαµηλών σχετικά ενεργειών όπως τα φωτόνια 140keV του 99mTc και τα 

φωτόνια 70keV του 201Τl. Οι εκπεµπόµενες ακτίνες-γ διαπερνούν τους ιστούς και 

καταγράφονται από µια ανιχνευτική διάταξη σε διάφορες γωνίες γύρω από τον 

ασθενή. 

Μια ή περισσότερες γ-κάµερα  περιστρέφονται γύρω από τον ασθενή µε 

σκοπό να παραχθούν οι SPECT εικόνες. Συλλέγονται προβολές της κατανοµής του 

ραδιοφαρµάκου στην υπό µελέτη περιοχή κατά τη διάρκεια της περιστροφής, 

συνήθως κάθε 3-6 µοίρες. Στις περισσότερες περιπτώσεις µια ολόκληρη περιστροφή 

360 µοιρών χρησιµοποιείται για να επιτευχθεί η ιδανική ανακατασκευή. Ο χρόνος 

που απαιτείται για κάθε προβολή είναι επίσης µεταβλητός, αλλά 15-20 δευτερόλεπτα 

είναι µια τυπική τιµή, το οποίο σηµαίνει συνολικό χρόνο για την συλλογή όλων των 

προβολών 15-20 λεπτά. 
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Σχήµα 1.4: Συλλογή δεδοµένων SPECT µέσω µιας γ-κάµερας συνδεδεµένης µε 

υπολογιστή.[4] 
 

Το απεικονιζόµενο όργανο διαχωρίζεται µε τη βοήθεια του υπολογιστή σε 

ξεχωριστές επιφάνειες (slices) και ανιχνεύονται τα φωτόνια τα προερχόµενα από 

κάθε επιφάνεια. Κάθε ανιχνευτής, συνδεδεµένος µε κατευθυντήρα παράλληλων 

οπών, δίνει ένα σύνολο δισδιάστατων προβολών χρησιµοποιώντας µονοφωτονιακές 

τεχνικές µέτρησης (single photon counting). Αυτές οι προβολές, συνδυαζόµενες 

κατάλληλα στον υπολογιστή µε την εφαρµογή ενός αλγόριθµου ανακατασκευής, 

επιτρέπουν την κατασκευή εγκάρσιας εικόνας η οποία αναπαριστά την κατανοµή του 

ραδιοφαρµάκου στο υπό µελέτη όργανο ή δοµή. Μ’ αυτό τον τρόπο µπορούµε να 

µελετήσουµε τη µορφολογία και τη λειτουργικότητα του υπό µελέτη οργάνου ή 

δοµής. 

Στην κλινική πυρηνική ιατρική χρησιµοποιούνται ανιχνευτικές διατάξεις γ-

camera τύπου Anger (Anger Scintillation Camera). Αποτελούνται από ένα µόνο 

κρύσταλλο NaI(Tl), αρκετά µεγάλης διαµέτρου, ώστε να είναι δυνατή η απεικόνιση 
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ενός µεγάλου τµήµατος του ανθρώπινου σώµατος και µια διάταξη 

φωτοπολλαπλασιαστών. Η ακτινοβολία η οποία περνά από τον κατευθυντήρα 

συναντά τον κρύσταλλο του σπινθηριστή, όπου έχουµε απορρόφηση φωτονίων και 

παραγωγή σπινθηρισµών στο σηµείο απορρόφησης. Η ένταση των σπινθηρισµών 

είναι ανάλογη των ακτίνων-γ. Η φωτοκάθοδος των φωτοπολλαπλασιαστών, η οποία 

βρίσκεται πίσω από τον κρύσταλλο µαζί µε το λογικό κύκλωµα θέσης, καθορίζουν τη 

θέση κάθε σπινθηρισµού που παράγεται στον κρύσταλλο, δηµιουργώντας ένα 

αποτύπωµα των σπινθηρισµών το οποίο περιγράφει την κατανοµή της ραδιενέργειας 

του υπό µελέτη δείγµατος. Κάθε φωτοπολλαπλασιαστής παράγει ηλεκτρικό παλµό 

του οποίου το εύρος είναι ανάλογο προς την ένταση του φωτός που διεγείρει την 

φωτοκάθοδο. Ο αναλυτής ύψους παλµών (pulse-height analyser) καθορίζει τα 

γεγονότα που θα καταγραφούν. Με βάση την ενέργεια του παλµού (αν είναι εντός του 

προεπιλεγµένου “ενεργειακού παραθύρου” της συσκευής), επιτρέπεται η είσοδος του 

από το διευκρινιστή και µεταφέρεται σε µήτρα κωδικοποίησης. Η γ-camera µπορεί να 

χρησιµοποιηθεί για µελέτη είτε στατικής εικόνας, στην οποία η εικόνα µιας σταθερής 

κατανοµής των ραδιοϊσοτόπων καταγράφεται για ένα παρατεταµένο χρόνο (π.χ. 

λεπτά), είτε δυναµικής εικόνας, στην οποία παρατηρούνται αλλαγές στην κατανοµή 

των ραδιονουκλιδίων τόσο γρήγορα όσο αρκετές εικόνες ανά δευτερόλεπτο. 

 
 

 
Σχήµα 1.5: Βασικές αρχές και τµήµατα της Anger camera. 
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Τα συστήµατα SPECT αποτελούνται από µια ή περισσότερες οµάδες 

ανιχνευτών, διατεταγµένους σύµφωνα µε κάποια ειδική γεωµετρία και οι οποίοι 

κινούνται µε κάποια µηχανισµό ώστε να λαµβάνονται δεδοµένα από διαφορετικές 

γωνίες. Τα συστήµατα SPECT µπορούν χωρισθούν στις ακόλουθες κατηγορίες.  

• Συστήµατα πολλών ανιχνευτών . Οι διατάξεις των ανιχνευτών µπορεί να είναι 

σε σχήµα τετραγώνου, κύκλου ή οι ανιχνευτές µπορούν να σαρώνουν τόσο 

ακτινικά όσο και εφαπτοµενικά. 

• Συστήµατα βασισµένα στην Anger Camera. Αποτελούνται από µια ή 

περισσότερες Anger Cameras που µπορούν να περιστρέφονται γύρω από τον 

ασθενή και οι διατάξεις τους ποικίλουν. Ορισµένα παραδείγµατα διατάξεων 

είναι τα εξής : µια κάµερα, δυο κάµερες τοποθετηµένες αντιδιαµετρικά κατά 

τη διάρκεια  της περιστροφής, δυο κάµερες που σχηµατίζουν ορθή γωνία, 

τρεις κάµερες σε τρίγωνο και τέσσερις κάµερες σε τετράγωνο.  

• Υβριδικά συστήµατα. Είναι συστήµατα που συνδυάζουν τις δυο 

προηγούµενες κατηγορίες. Παράδειγµα : Το CERESPECT brain SYSTEM 

που αποτελείται από ένα σταθερό κυκλικό κρύσταλλο NaI(TI) και έναν 

περιστρεφόµενο κυκλικό ευθυγραµµιστή.  

Τα περισσότερα συστήµατα απεικόνισης ακτίνων-γ που χρησιµοποιούνται 

στην πράξη βασίζονται στην αρχή της απορροφητικής κατευθυντικότητας (absorptive 

collimation) για την παραγωγή εικόνας. Ο κατευθυντήρας που χρησιµοποιείται, 

καθορίζει την περιοχή από όπου φωτόνια µπορούν να εισέλθουν στον ανιχνευτή 

σπινθηρισµού και είναι εκείνα που ταξιδεύουν κατά µήκος µόνο συγκεκριµένων 

διευθύνσεων, ενώ φωτόνια που δεν ταξιδεύουν στη σωστή κατεύθυνση 

απορροφώνται από τον κατευθυντήρα. Η χρήση του κατευθυντήρα συντελεί, 

εποµένως, σε επιλογή των φωτονίων που ανιχνεύονται από τη γ-camera και ως εκ 

τούτου ρυθµίζει την ένταση της διερχόµενης ακτινοβολίας. Επίσης καθορίζει το 

γεωµετρικό οπτικό πεδίο και προσδιορίζει τη διακριτική ικανότητα και ευαισθησία 

του συστήµατος.  

Υπάρχουν τέσσερα βασικά είδη κατευθυντήρων τα οποία χρησιµοποιούνται 

στη γ-camera: α) Κατευθυντήρας τύπου καρφίδος (pinhole), β) Κατευθυντήρας µε 

συστήµατα παράλληλων οπών (parallel hole collimator), γ) Κατευθυντήρας µε 

αποκλίνουσες οπές (diverging collimator) και δ) Κατευθυντήρας µε συγκλίνουσες 

οπές (converging collimator).[1, 4-7] 
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1.4  Στόχος εργασίας 
 

Στόχος της εργασίας ήταν η ανάπτυξη ενός γραφικού εργαλείου 

ανακατασκευής εικόνων τοµών  από δεδοµένα τοµογραφίας SPECT. Για το σκοπό 

αυτό ήταν απαραίτητη η εξοικείωση µε το εργαλείο  Qt, το οποίο είναι  κατάλληλο 

για την ανάπτυξη γραφικού περιβάλλοντος µε τη γλώσσα C++.  Το Qt είναι cross-

platform, δηλαδή λειτουργεί και είναι δυνατή η ανάπτυξη  εφαρµογών σε 

διαφορετικές πλατφόρµες και διαφορετικά λειτουργικά συστήµατα  (Windows, 

Linux, Mac OS). Αρχικά, ήταν αναγκαία η απόκτηση εµπειρίας µέσα από τη µελέτη 

βιβλιογραφίας για το εργαλείο αυτό και τη συγγραφή µικρών προγραµµάτων.   

Στη συνέχεια πραγµατοποιήθηκε βιβλιογραφική επισκόπηση της πυρηνικής 

ιατρικής απεικόνισης και  των µεθόδων τοµογραφικής ανακατασκευής. 

Επικεντρωθήκαµε στους επαναληπτικούς αλγορίθµους ανακατασκευής MLEM και 

OSEM. Τα προγράµµατα για την κατασκευή του πίνακα πιθανοτήτων συστήµατος 

καθώς και για τους παραπάνω αλγορίθµους  ανακατασκευής ήταν διαθέσιµα σε 

γλώσσα C. Ένας από τους στόχους της εργασίας ήταν η µετατροπή αυτών των 

προγραµµάτων σε γλώσσα C++ και η σύνδεσή τους µε το γραφικό περιβάλλον της 

εφαρµογής.  

Τέλος, εισήχθησαν κάποιες βασικές λειτουργίες επεξεργασίας των εικόνων 

των τοµών, όπως δυνατότητα για zoom in, zoom out, χρωµατική απόχρωση και 

παραγωγή εικόνας  δέκα  χρωµάτων από µια µονόχρωµη εικόνα σύµφωνα µε µια 

συγκεκριµένη παλέτα χρωµάτων.  Το λογισµικό δοκιµάστηκε µε  κλινικά δεδοµένα, 

τα οποία παρήχθησαν από SPECT/CT camera Varicam, του οίκου GE Medical από 

την κλινική Charite Verichow του Βερολίνου. 
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ΚΕΦΑΛΑΙΟ  2  

 

Τοµογραφική ανακατασκευή σε SPECT 

 

 

2.1 Οπισθοπροβολή 

 

Για την ανακατασκευή µίας τοµογραφικής εικόνας από τις συλλεγόµενες 

προβολές, ο πιο απλός τρόπος είναι η οπισθοπροβολή. ∆ηµιουργούµε µια εικόνα  

οπισθοπροβάλοντας µια προβολή σε κάθε γωνία σε όλα τα pixel στην κατεύθυνση 

της προβολής. Η διαδικασία αυτή φαίνεται στο σχήµα 2.1. ∆ιαδοχικά 

οπισθοπροβάλλονται οι προβολές σε 3,5,9 και 18 γωνίες. Η εικόνα που σχηµατίζεται 

από την άθροιση όλων των οπισθοπροβολών, προσεγγίζει σταδιακά το αντικείµενο. 

 
Σχήµα 2.1: ∆ιαδικασία οπισθοπροβολής. Οπισθοπροβολή 3,5,9 και 18 προβολών. 
 

Αυξάνοντας τις προβολές η ποιότητα της ανακατασκευής βελτιώνεται. Το 

µειονέκτηµα της διαδικασίας αυτής είναι πως εκτός από το πραγµατικό αντικείµενο 

στην ανακατασκευασµένη εικόνα υπάρχει υψηλός θόρυβος, ο οποίος οφείλεται στις 

οπισθοπροβολές και έχει την µορφή ακτινικών γραµµών (star artifacts). Επίσης, οι 

αιχµές της εικόνας δεν είναι σαφώς καθορισµένες και σε περιοχές οµοιοµορφίας της 

εικόνας, η ανακατασκευασµένη εικόνα παρουσιάζει µη πραγµατική ενίσχυση προς το 

κέντρο. Όσο πολυπλοκότερο είναι το προς ανακατασκευή αντικείµενο, τόσο 
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πολυπλοκότερες είναι οι προβολές και κατά συνέπεια εντονότερος ο θόρυβος, µε 

αποτέλεσµα η ανακατασκευή να είναι σε πολλές περιπτώσεις ανεπιτυχής. 

Θεωρητικά η οπισθοπροβολή (ο αντίστροφος µετασχηµατισµός Radon) δίνει 

τέλειες ανακατασκευές, όταν ένας άπειρος αριθµός προβολών είναι γνωστός. Στην 

πράξη αυτό δεν είναι ποτέ δυνατό αφενός γιατί οι ανιχνευτικές διατάξεις έχουν ένα 

πεπερασµένο βήµα δειγµατοληψίας και αφετέρου –στην ιατρική απεικόνιση- επειδή ο 

χρόνος ανίχνευσης/εξέτασης πρέπει να είναι όσο το δυνατό συντοµότερος. Για το 

λόγο αυτό έχουν αναπτυχθεί αλγόριθµοι προεπεξεργασίας και φιλτραρίσµατος των 

προβολών, ώστε η οπισθοπροβολή να µην συνοδεύεται από έντονο θόρυβο. Ο πιο 

σηµαντικός είναι ο αλγόριθµος της φιλτραρισµένης οπισθοπροβολής (Filtered 

Backprojection – FBP). [1] 

 

 
Σχήµα 2.2: Προβολές και οπισθοπροβολές σε διάφορες γωνίες τεσσάρων κύκλων. 
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2.2 Φιλτραρισµένη οπισθοπροβολή 
 

Ο αλγόριθµος FBP χρησιµοποιείται σε όλα τα κλινικά συστήµατα 

τοµογραφίας και το σηµαντικότατο πλεονέκτηµά του είναι η εύκολη υλοποίηση του 

σε υπολογιστή, µε τρόπο ώστε η ανακατασκευή των τοµογραφικών εικόνων να 

γίνεται σε πραγµατικό χρόνο. Αποτελείται από δύο βήµατα: 1) Εφαρµογή ενός 

κατάλληλου φίλτρου h(t) στα δεδοµένα προβολής και 2) Οπισθοπροβολή των 

διαµορφωµένων δεδοµένων προβολής για τη δηµιουργία της εικόνας. Το πρώτο βήµα 

υλοποιείται σε τρία στάδια: α) Μετασχηµατισµός Fourier των δεδοµένων προβολής 

στο χώρο των συχνοτήτων ω µε τη χρήση µεθόδου FFT (Fast Fourier Transform), β) 

Πολλαπλασιασµός των κατά Fourier µετασχηµατισµένων δεδοµένων προβολής µε 

µια κατάλληλη συνάρτηση H(ω), που είναι ο µετασχηµατισµός Fourier της 

συνάρτησης φίλτρου h(t) και γ) Αντίστροφος µετασχηµατισµός Fourier στο χώρο. 

 

 
(α)                                     (β) 

 

Σχήµα 2.3: Ανακατασκευή µε οπισθοπροβολή: (α) χωρίς φιλτράρισµα και (β) µε φιλτράρισµα των 
προβολών. 

 

Η συνάρτηση Η(ω) που χρησιµοποιείται είναι η απόλυτη τιµή της συχνότητας 

|ω|. Τα φιλτραρισµένα δεδοµένα προβολής οπισθοπροβάλονται και προκύπτει η 

ανακατασκευασµένη εικόνα. Ο αλγόριθµος FBP δίνει τα ίδια αποτελέσµατα µε τη 

µέθοδο του αντίστροφου µετασχηµατισµού Fourier, αλλά είναι πιο εύκολος να 

εφαρµοστεί. ∆ύο είναι τα βασικά πλεονεκτήµατα του αλγόριθµου FBP, σε σχέση µε 

την παρεµβολή στο χώρο της συχνότητας: 

• Η ανακατασκευή µπορεί να αρχίσει από τη στιγµή, που λαµβάνεται η πρώτη 

προβολή. Αυτό έχει ως αποτέλεσµα να επιταχύνεται η διαδικασία και να µειώνεται 

ο όγκος της πληροφορίας, που αποθηκεύεται κάθε φορά. 

• Είναι ευκολότερο να γίνεται παρεµβολή στον πραγµατικό χώρο, παρά στο χώρο 

της συχνότητας. Παρεµβολή είναι αναγκαία και στην περίπτωση του αλγορίθµου 
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FBP. Στην περίπτωση αυτή η γραµµική παρεµβολή, παρέχει ικανοποιητικά 

αποτελέσµατα, ενώ στην περίπτωση του µετασχηµατισµού Fourier στο χώρο της 

συχνότητας, απαιτούνται πολυπλοκότερες µορφές παρεµβολής.[1, 8] 

 

 
 

 
 
 

 
Σχήµα 2.4 και Σχήµα 2.5 : Σύγκριση των αποτελεσµάτων µε φιλτραρισµένη και απλή οπισθοπροβολή 

για περισσότερες προβολές.[9] 
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2.3 Επαναληπτική ανακατασκευή και πίνακας 
συστήµατος 

 
 Η τεχνική των επαναληπτικών αλγορίθµων διαφέρει σε  µεγάλο βαθµό από 

την τεχνική της οπισθοπροβολής (filtered back projection FBP). Οι βασικές αρχές 

των επαναληπτικών αλγορίθµων ανακατασκευής µπορούν να συνοψιστούν στα  

παρακάτω. Η χωρική συνάρτηση κατανοµής της φυσικής ποσότητας f(x,y) από ένα 

πλέγµα αποτελούµενο από τετράγωνες περιοχές (pixels) σε κάθε µία από τις οποίες η 

τιµή της φωτεινότητας θεωρείται σταθερή. Η τοµογραφική ακτίνα αντιστοιχεί σε µία 

παράλληλη ζώνη εύρους ∆r . Η τιµή κάθε µέτρησης προβολής καθορίζεται από το 

εµβαδόν και την φωτεινότητα των pixels που τέµνει η τοµογραφική ακτίνα. Γίνεται 

µια αρχική εκτίµηση της συνάρτησης f(x,y), υπολογίζονται οι προβολές και 

συγκρίνονται µε τις υπάρχουσες µετρήσεις στις αντίστοιχες γωνίες. Εφαρµόζοντας 

ένα αλγόριθµο βασισµένο σε ειδικά στατιστικά κριτήρια οι διαφορές 

χρησιµοποιούνται για να διορθώσουν την αρχική εκτίµηση της εικόνας. Η διαδικασία 

επαναλαµβάνεται µέχρι η διαφορά της εκτίµησης και των µετρήσεων να γίνει αρκετά 

µικρή (µικρότερη µιας προκαθορισµένης µικρής τιµής). Τα στατιστικά κριτήρια που 

χρησιµοποιούνται περιλαµβάνουν προσεγγίσεις Minimum Mean Squares Error 

(MMSE), Weighted Least Squares (WLS), Maximum Entropy (ME), Maximum 

Likelihood (ML) και Maximum A Posteriori. 

Τα µειονεκτήµατα αυτών των αλγορίθµων είναι το αυξηµένο κόστος σε 

υπολογιστικό χρόνο και η µεγάλη χρονική διάρκεια της επεξεργασίας. Επίσης, Η  

ύπαρξη θορύβου στις µετρήσεις ενός υπερκαθορισµένου συστήµατος δεν επιτρέπει 

την σύγκλιση της µεθόδου. Ωστόσο, µπορεί να χρησιµοποιηθεί εκ των προτέρων 

γνώση σχετικά µε την εικόνα και ειδικά για την φωτεινότητα και την διάταξη των 

pixels µε σκοπό να αντισταθµιστούν τα φαινόµενα υποβάθµισης της εικόνας, 

µοντελοποιώντας τη διαδικασία απεικόνισης συµπεριλαµβανοµένων και των 

παραγόντων υποβάθµισης. Έτσι για παράδειγµα, µπορούν να παράγουν αποδεκτές 

εικόνες από περιορισµένο αριθµό όψεων, σε περιπτώσεις όπου η συλλογή δεδοµένων 

σε ορισµένες γωνίες δεν είναι εφικτή λόγω φυσικών περιορισµών. 

Το βασικότερο πλεονέκτηµα των επαναληπτικών αλγορίθµων είναι ότι 

επιτρέπουν να µοντελοποιηθούν πιστά οι διαδικασίες εκποµπής και ανίχνευσης. Σε 
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αντίθεση, στον αλγόριθµο οπισθοπροβολής δεν είναι δυνατή η µοντελοποίηση της 

εξασθένησης και του σκεδασµού των εκπεµπόµενων φωτονίων. Επίσης, η ποσότητα 

του θορύβου που περιέχει η τελική ανακατασκευή µιας εικόνας µε επαναληπτικό 

αλγόριθµο είναι πολύ πιο αποδεκτή από αυτήν που έχει χρησιµοποιηθεί ο αλγόριθµος 

οπισθοπροβολής. Τέλος,  η δυνατότητα ενσωµάτωσης πρόσθετης πληροφορίας, όπως 

η ενσωµάτωση ανατοµικής πληροφορίας στην µαγνητική τοµογραφία (MRI),  στην 

ανακατασκευή µε επαναληπτικούς αλγορίθµους  είναι ένα ακόµη ισχυρό 

πλεονέκτηµα των επαναληπτικών αλγορίθµων. [8, 10, 11] 

 
Σχήµα 2.6 : Σύγκριση ανακατασκευής µε οπισθοπορβολή (FBP) και µε επαναληπτικό αλγόριθµο (ΕΜ) 
για διαφορετικές συνολικές µετρήσεις. Ο θόρυβος για µικρό αριθµό µετρήσεων στον αλγόριθµο FBP 

είναι εµφανής.  
 

2.3.1 Γεωµετρικός πίνακας συστήµατος (SYSTEM MATRIX) 
 

Η υλοποίηση όλων των επαναληπτικών αλγόριθµων στηρίζεται στη γνώση του 

γεωµετρικού πίνακα του συστήµατος Ρ. Ο υπολογισµός του πίνακα γίνεται 

γεωµετρικά. Για κάθε ανιχνευτή, γωνία περιστροφής και pixel εικόνας βρίσκονται τα 

σηµεία τοµής του οπτικού πεδίου κάθε ανιχνευτή µε κάθε pixel, το είδος του 



 21

σχήµατος που προκύπτει και τελικά υπολογίζεται το εµβαδόν του. Στις περισσότερες 

περιπτώσεις δεν υπάρχει τοµή και το εµβαδόν αυτό είναι µηδενικό. Στις υπόλοιπες 

περιπτώσεις το προκύπτον σχήµα µπορεί να είναι τρίγωνο, τετράγωνο, τραπέζιο, 

πεντάγωνο ή εξάγωνο, όπως µπορεί να παρατηρηθεί και στο σχήµα 3.2, όπου έχει 

υποτεθεί µια περίπτωση εικόνας 8x8. 

 
 

 
 

Σχήµα 2.7: Περιστροφή ενός ανιχνευτή αποτελούµενου από 8 κυψελίδες και τα εµβαδά που 

σχηµατίζει η ζώνη ανίχνευσης µε τα pixel της προς ανακατασκευή εικόνας.  

 

Ο υπολογισµός των εµβαδών µπορεί να απλοποιηθεί αν ληφθούν υπόψη οι 

συµµετρίες που υπάρχουν στο σχήµα. Στην παρούσα υλοποίηση το κέρδος από την 

αξιοποίηση των συµµετριών είναι µόνο η µείωση του υπολογιστικού χρόνου εύρεσης 

του πίνακα. Όµως τροποποιώντας τον κώδικα του αλγόριθµου, είναι δυνατόν να 

αποθηκεύεται µόνο ένα µέρος του πίνακα µε προφανή οφέλη κατά την ανακατασκευή 

µιας εικόνας µεγαλύτερων διαστάσεων, όπου ο χρόνος προσπέλασης του πίνακα είναι 

µεγαλύτερος. Οι συµµετρίες αυτές µπορούν να αξιοποιηθούν και σε µια υλοποίηση 

που θα υπολογίζει απευθείας τα στοιχεία pij, χωρίς να αποθηκεύει τον πίνακα. 

Ενδεικτικά, στην περίπτωση µιας εικόνας 128x128, όπου λαµβάνονται 36 γωνίες ο 

χρόνος υπολογισµού του πίνακα είναι περίπου 1 λεπτό. Ωστόσο, στην περίπτωση της 

τριασδιάστατης τοµογραφικής ανακατασκευής ο χρόνος αυτός αυξάνεται σηµαντικά, 

καθώς και οι απαιτήσεις αποθήκευσης και διαχείρισης του πίνακα αυτού. 
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Οι σηµαντικότερες συµµετρίες είναι οι εξής:  

1) Η πρώτη αφορά στη σειρά µε την οποία κάθε ανιχνευτής βλέπει τα pixels στις 0º, 

90º, 180º και 270º. Αξιοποιώντας τη συµµετρία αυτή είναι δυνατόν να γίνουν οι 

υπολογισµοί των εµβαδών µόνο στο διάστηµα 0º<θ<90º. Έτσι οι απαιτούµενοι 

υπολογισµοί περιορίζονται στο ¼. Με δεξιόστροφη φορά περιστροφής οι θέσεις από 

τις οποίες περνά ο ανιχνευτής και οι σχετικές θέσεις του ως προς την εικόνα στις 0º, 

90º, 180º και 270º φαίνονται στο σχήµα 3.3:  

 
Σχήµα 2.8: Σχετικές θέσεις ανιχνευτών και pixels εικόνας στις 0º, 90º, 180º και 270º. 

 

2) Η δεύτερη συµµετρία αφορά στη σχετική θέση των ανιχνευτών και των pixels σε 
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συγκεκριµένες γωνίες. ∆ιαπιστώνεται ότι υπάρχει συµµετρία της µορφής: 

∆ηλαδή στην περίπτωση που υπάρχουν 8 ανιχνευτές ό,τι “βλέπει” ο ανιχνευτής 1 

σε µια γωνία θ, το βλέπει µε την αντίστροφη σειρά ο ανιχνευτής 8 στη γωνία 180+θ 

κ.ο.κ. Έτσι είναι δυνατόν οι υπολογισµοί να περιοριστούν στους µισούς ανιχνευτές µε 

αποτέλεσµα τον υποδιπλασιασµό του απαιτούµενου χρόνου. 

Ο γεωµετρικός πίνακας πρέπει να περιέχει τις πιθανότητες ανίχνευσης ενός 

φωτονίου που εκπέµπεται από ένα pixel σε κάθε ανιχνευτή. Για να γίνει αυτό πρέπει 

να διαιρεθεί το κάθε εµβαδόν µε το άθροισµα των εµβαδών που σχηµατίζει το pixel 

αυτό µε όλες τις ζώνες ανίχνευσης όλων των ανιχνευτών. Με τον τρόπο που έχει 

οριστεί ο πίνακας του συστήµατος, το µόνο που απαιτείται να γίνει είναι να διαιρεθεί 

κάθε στοιχείο µιας γραµµής µε το άθροισµα των στοιχείων της γραµµής αυτής. Ο 

πίνακας που προκύπτει είναι ο πίνακας πιθανοτήτων του συστήµατος.   [10-12] 

 

2.4 Επαναληπτική ανακατασκευή µε MLEM 
 

Το 1979 οι L. Shepp και Υ. Vardi, παρουσίασαν ένα µαθηµατικό µοντέλο για 

την τοµογραφία εκποµπής, όπου µία άγνωστη πυκνότητα εκποµπής (κατανοµή της 

συγκέντρωσης του ραδιοϊσοτόπου) λ=λ(x,y,z) µπορεί να υπολογιστεί όταν είναι 

γνωστός ένας αριθµός κρούσεων σε ένα πλήθος ανιχνευτών. Ο αλγόριθµος 

ονοµάστηκε Maximum Likelihood Expectation Maximization (MLEM) και λαµβάνει 

υπόψη τη στατιστική φύση της εκποµπής ακτινοβολίας από µία πηγή. Σε κάθε 

επανάληψη υπάρχει ένα βήµα πρόβλεψης (expectation), το οποίο χρησιµοποιεί τις 

τρέχουσες εκτιµήτριες των τιµών των pixels και ακολουθείται από ένα βήµα µεγίστης 

πιθανοφάνειας (maximum likelihood), που ανανεώνει τις εκτιµήτριες αυτές. 

Έστω ότι η προς απεικόνιση κατανοµή διακριτοποιείται σε στοιχειώδεις 

όγκους (voxels) ή σε στοιχειώδεις επιφάνειες (pixels). Για απλότητα περιορίζεται η 

ανάλυση στις δύο διαστάσεις. Έστω ότι η εικόνα έχει διαστάσεις nxn και άρα 

αποτελείται από n2 pixels. Έστω επίσης ότι για την ανακατασκευή µίας τοµής είναι 

γνωστή η πληροφορία από D συνολικά ανιχνευτές. Στην περίπτωση του SPECT 

υποτίθεται ότι κάθε ανιχνευτής αποτελείται από n στοιχειώδεις ανιχνευτές και για θ 

γωνίες περιστροφής D=nxθ, αφου ο ίδιος ανιχνευτής δίνει ανεξάρτητες πληροφορίες 

σε διαφορετικές γωνίες. Επιπλέον απαιτείται ο υπολογισµός του πίνακα πιθανοτήτων 
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P του συστήµατος. Ένα τυχαίο στοιχείο του πίνακα pij δίνει την πιθανότητα ένα 

φωτόνιο, που εκπέµπεται από ένα pixel i να ανιχνευθεί από τον ανιχνευτή j. 

Η εκκίνηση του αλγορίθµου γίνεται από µία τυχαία εικόνα, κάθε pixel της 

οποίας έχει την ίδια τιµή. Χρησιµοποιώντας τις µετρούµενες προβολές της εικόνας σε 

διάφορες γωνίες σε κάθε επανάληψη k γίνεται ανανέωση των εκτιµούµενων τιµών 

των pixels της εικόνας Ik µε βάση την ακόλουθη σχέση: 

∑∑=

+ =
D
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k
iij

jijkk
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dp

II
1det

1  

[8, 10, 11, 13, 14] 

 

2.5 Επαναληπτική ανακατασκευή µε OSEM 
  

Ο αλγόριθµος διατεταγµένων υποσυνόλων (Ordered Subsets Expectation 

Maximization –OSEM) παρουσιάστηκε το 1994 από τους Hudson και Larkin. 

Βασίζεται στην ίδια ιδέα µε τον ML-EM, αλλά συγκλίνει πολύ πιο γρήγορα. Η 

βασική του καινοτοµία είναι ότι χωρίζει το σύνολο των προβολών σε υποσύνολα 

(subsets) και εφαρµόζει τον MLA, σε καθένα από αυτά ως εξής: 

Έστω ένα σύνολο Τ={Τ1, Τ2, Τ3, ...} προβολών το οποίο χωρίζεται σε n 

υποσύνολα. Η επιλογή των υποσυνόλων µπορεί να γίνει µε διάφορους τρόπους και 

αυτά να είναι διαδοχικά ή επικαλυπτόµενα. ∆ηλαδή το πρώτο σύνολο 

S1=(T1,T2,…Tκ), το δεύτερο S2=(Tm+1, Tm+2, …T2m), …., το τελευταίο Sk=(T(k-1)m+1, 

T(k-1)m+2,…Tkm) ή για επικαλυπτόµενα S1=(T1,T2,…Tm), το δεύτερο S2=(T1,T2,…Tm, 

Tm+1, Tm+2, …T2m), …., το τελευταίο Sk=( T1,T2,…Tm, Tm+1, Tm+2, …T2m, T(k-1)m+1, 

T(k-1)m+2,…Tkm).  

Η εκκίνηση του αλγορίθµου γίνεται και πάλι από ένα οµοιόµορφο πίνακα. Στο 

πρώτο υποσύνολο των προβολών εφαρµόζεται ο ΜLΕΜ, το αποτέλεσµα που 

προκύπτει χρησιµοποιείται ως αρχική εικόνα για εφαρµογή του MLΕΜ του δευτέρου 

υποσυνόλου, το αποτέλεσµα που προκύπτει χρησιµοποιείται ως αρχική εικόνα για 

τον MLΕΜ του τρίτου υποσυνόλου κ.ο.κ. Η εφαρµογή του ΜLEM σε ένα τέτοιο 

υποσύνολο ονοµάζεται επίπεδο (level). Μόλις συµπληρωθούν όλα τα επίπεδα έχει 

ολοκληρωθεί µία επανάληψη του OSEM, η οποία διαρκεί τελικά περίπου όσο και µία 

επανάληψη του MLΕΜ, ενώ η ανακατασκευή συγκλίνει πολύ πιο γρήγορα. Κατά 
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αντιστοιχία µε τον MLEM η ανανέωση των εκτιµούµενων τιµών των pixel της 

εικόνας Ik γίνεται µε βάση την ακόλουθη σχέση: 

 

∑ ∑=
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1det

1
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k
iij

jijkk
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dp

II  

όπου Sp(n) είναι οι προβολές του υποσυνόλου n. 

Είναι επίσης σηµαντικό να επιλεγεί ο κατάλληλος αριθµός υποσυνόλων (άρα 

και levels) και ο αριθµός των επαναλήψεων, ώστε ποιοτικά αποδεκτές εικόνες να 

λαµβάνονται γρήγορα. Ο OSEM έφερε µία µικρή επανάσταση στον τοµέα της 

επαναληπτικής ανακατασκευής τοµογραφικών εικόνων και σήµερα οι περισσότερες 

εταιρίες κατασκευής τοµογραφικών συστηµάτων παρέχουν απλοποιηµένες εκδόσεις 

του OSEM –συνήθως ως επιπλέον προσφορά- στο λογισµικό των συστηµάτων 

SPECT και PET. [8, 15, 16] 
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ΚΕΦΑΛΑΙΟ  3  

 

ΑΝΑΠΤΥΞΗ ΠΡΟΓΡΑΜΜΑΤΟΣ 

 

3.1 Το εργαλείο Qt 

3.1.1 Εισαγωγή στο Qt  
 

Το Qt  είναι ένα εργαλείο ανάπτυξης εφαρµογών µε γραφικό περιβάλλον  για 

τη γλώσσα C++.   Το κύριο χαρακτηριστικό του είναι ότι δίνει τη δυνατότητα στον 

προγραµµατιστή να αναπτύξει εφαρµογές, τις οποίες θα µπορεί να µεταγλωττίσει και 

να τρέξει σε διαφορετικά λειτουργικά συστήµατα (Windows, Mac OS X, Linux, 

Unix).  Ένα µεγάλο µέρος του Qt  είναι προορισµένο στο να παράγει ανεξάρτητο 

πλατφόρµας γραφικό περιβάλλον σε οτιδήποτε από  αναπαράσταση χαρακτήρων στη 

µνήµη µέχρι τη δηµιουργία εφαρµογών µε πολυνηµατικού (multithread) γραφικό 

περιβάλλον. Οι εφαρµογές σε C++, που αναπτύσσονται µε το Qt, τρέχουν σε όλα τα 

υποστηριζόµενα λειτουργικά συστήµατα χωρίς αλλαγές στον κώδικα. Οι 

σηµαντικότερες εφαρµογές που έχουν αναπτυχθεί µε το Qt είναι το γραφικό 

περιβάλλον εργασίας για σταθµούς UNIX, KDE, ο web browser Opera, Google 

Earth, Skype κ.ά..   

Το  Qt  δηµοσιεύτηκε και εισήλθε στην αγορά αρχικά τον Μάιο του 1995. Οι 

αρχικές εκδόσεις του είχαν αναπτυχθεί από τους Νορβηγούς  Haavard Nord  και  

Eirik Chambe-Eng. Στις 20 Μαΐου του 1995 η   ανέβηκε στο διαδίκτυο η πρώτη 

δηµόσια έκδοση του Qt (0.90) . Η τελευταία έκδοση κυκλοφόρησε το καλοκαίρι του 

2005 , το Qt 4,  και περιέχει σχεδόν 500 κλάσεις και πάνω από 9000 συναρτήσεις 

οργανωµένες σε διαφορετικές βιβλιοθήκες έτσι ώστε να είναι ευκολότερη η ανάπτυξη 

µιας εφαρµογής.  [17, 18] 

 

 



 27

3.1.2 Τα  βασικότερα στοιχεία του Qt 
 
 Το Qt 4 αποτελείται  από διαφορετικές ενότητες,  η κάθε µια από τις οποίες 

ανήκει σε διαφορετική βιβλιοθήκη και οι οποίες υποστηρίζουν ανάπτυξη γραφικού 

περιβάλλοντος(GUI), Βάσεις ∆εδοµένων (Database), XML, προγραµµατισµό δικτύων 

(networking), σύνδεση µε τη βιβλιοθήκη Open GL, Multithreading και άλλα.   

 

QtCore Core non-GUI classes used by other modules 
QtGui Graphical user interface components 
QtNetwork Classes for network programming 
QtOpenGL OpenGL support classes 
QtSql Classes for database integration using SQL 
QtScript Classes for evaluating Qt Scripts 
QtSvg Classes for displaying the contents of SVG files 
QtXml Classes for handling XML 
QtDesigner Classes for extending Qt Designer 
QtUiTools Classes for handling Qt Designer forms in applications 
QtAssistant Support for online help 
Qt3Support Qt 3 compatibility classes 
QtTest Tool classes for unit testing 

 Σχήµα 3.1 : Οι ενότητες (modules) του Qt 4 

 

Η βασικότερη ενότητα (module) είναι το QtCore, πάνω στην οποία βασίζονται 

οι υπόλοιπες ενότητες. Περιέχει γενικές κλάσεις, που µπορούν να χρησιµοποιηθούν 

από οποιαδήποτε εφαρµογή όπως  κλάσεις για διάβασµα και γράψιµο αρχείων 

(QFile), για ροή δεδοµένων (QDataStream),  για λίστες ή συνδεδεµένες λίστες (QList 

, QlinkedList), για επεξεργασία συµβολοσειρών (Qstring) και πολλές άλλες.  

Η ενότητα για το γραφικό περιβάλλον (QtGui module) περιέχει κλάσεις για 

την ανάπτυξη εφαρµογών µε γραφικό περιβάλλον. Τέτοιες είναι  κλάσεις για τον 

έλεγχο της ροής  και των ρυθµίσεων της εφαρµογής (QApplication), για την εισαγωγή 

γραφικών στοιχείων  για την επικοινωνία µε τον χρήστη (QPushButton ,  

QCheckButton, QDialog, QLabel κ.α.), για την επεξεργασία εικόνας (QImage, 

QPicture κ.α.).  

Οι κλάσεις είναι ιεραρχικά δοµηµένες περνώντας από τις αφηρηµένες 

γενικότερες κλάσεις σε συγκεκριµένες και ειδικότερες. Για παράδειγµα η κλάση 
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QPushButton, που αναπαριστά ένα κουµπί, κληρονοµεί από την αφηρηµένη κλάση 

QButton και η οποία µε τη σειρά της κληρονοµεί από την QWidget  κ.ο.κ..  

Πέρα από τα βασικά στοιχεία ενός γραφικού περιβάλλοντος, όπως κουµπιά, 

περιοχές κειµένου, λίστες κλπ. , τα οποία στο Qt  κληρονοµούν από µια γενική, την 

QWidget , θα ήταν ενδιαφέρον σε αυτό το σηµείο να εξετάσουµε δυο άλλα σηµεία, το 

πώς επικοινωνούν αυτά τα στοιχεία µεταξύ τους και πως δοµούνται τα γεγονότα 

(events) στο Qt. [19] 

3.1.3  Η λειτουργία  Signals and Slots    
  

 Η λειτουργία Signals and Slots  χρησιµοποιείται για την επικοινωνία µεταξύ 

αντικειµένων.  Στο προγραµµατισµό γραφικών περιβαλλόντων (GUI) όταν 

µεταβάλλουµε µια ιδιότητα ενός στοιχείου (π.χ. µιας ετικέτας) , τα οποία στο εξής θα 

τα λέµε widgets,  συχνά θέλουµε  ένα άλλο widget  να ειδοποιηθεί για αυτό. 

Γενικότερα θέλουµε αντικείµενα κάθε είδους να µπορούν να επικοινωνήσουν µεταξύ 

τους. Για παράδειγµα όταν πατάµε το κουµπί Close σε ένα πρόγραµµα λογικά 

θέλουµε να κληθεί η συνάρτηση Close() του προγράµµατός µας.  

 Ένα σήµα (signal) εκπέµπεται όταν συµβαίνει ένα συγκεκριµένο γεγονός. Τα 

widget του Qt έχουν αρκετά προδιαµορφωµένα σήµατα, αλλά κάποιος µπορεί να 

φτιάξει υποκλάσεις  αυτών για να προσθέσει τα δικά του σήµατα. Το slot είναι η 

συνάρτηση που καλείται σαν απάντηση σε κάποιο συγκεκριµένο σήµα και υπάρχουν 

και εδώ πολλά προδιαµορφωµένα slot ,αν και κάποιος µπορεί αν προσθέσει τα δικά 

του σε υποκλάσεις για διαχειριστεί τα σήµατα που τον ενδιαφέρουν.  

 Οι συναρτήσεις Slots  είναι κανονικές συναρτήσεις µέλη της    C++  και 

µπορούν να είναι εικονικές, να υπερφοτωθούν, να είναι δηµόσιες, προστατευµένες ή 

ιδιωτικές, µπορούν να προσπελασθούν όπως κάθε άλλη συνάρτηση της C++ και 

µπορούν να έχουν παραµέτρους οποιαδήποτε τύπου.  Η διαφορά έγκειται στο ότι ένα 

slot µπορεί να συνδεθεί µε ένα signal, όπου και καλείται αυτόµατα κάθε φορά που 

εκπέµπεται το signal.  Η πρόταση connect(), η οποία συνδέει ένα signal µε ένα slot 

έχει την παρακάτω µορφή:   

 

connect(sender, SIGNAL(signal), receiver, SLOT(slot)); 
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όπου τα sender και receiver είναι δείκτες σε αντικείµενα QObjects  και τα signal και 

slot είναι ονόµατα συναρτήσεων χωρίς τα ονόµατα των παραµέτρων τους.  

 Παράδειγµα: 

connect(slider, SIGNAL(valueChanged(int)),spinBox, SLOT(setValue(int))); 

Με αυτήν την πρόταση συνδέουµε ένα slider µε ένα spinbox. Όταν αλλάζει η τιµή 

στο slider εκπέµπεται ένα σήµα, το οποίο λαµβάνει ένα slot στο spinbox και αλλάζει 

την τιµή του spinbox.  

 Μπορεί κάποιος να συνδέσει όσα signals θέλει σε ένα slot και ένα signal 

µπορεί να συνδεθεί σε όσα slot χρειάζεται. Επίσης είναι δυνατό η εκποµπή ενός 

signal να πυροδοτεί την εκποµπή ενός άλλου signal αν συνδέσουµε το πρώτο µε το 

δεύτερο.  [19] 

Σχήµα 3.2: Οι πιθανές συνδέσεις αντικειµένων µε την τεχνική Signals and Slots. 

3.1.4  Αντιµετώπιση των γεγονότων στο Qt 
 Όλες οι εφαρµογές, που κατασκευάζονται µε το Qt είναι οδηγούµενες από 

γεγονότα(event-driven) και γι' αυτό το λόγο δεν µπορεί κάποιος να ακολουθήσει το 

µονοπάτι εκτέλεσης από συνάρτηση main προς όλα τα µέρη της εφαρµογής. 

Αντιθέτως, η εφαρµογή αρχικοποιείται από τη συνάρτηση main, η οποία καλεί την 

µέθοδο exec()  σε ένα αντικείµενο QApplication και έτσι ξεκινάει ο βρόγχος 

γεγονότων του προγράµµατος (event loop).  Το αντικείµενο QApplication περιµένει 
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γεγονότα, τα οποία στη συνέχεια τα περνάει σε κάθε επηρεαζόµενο αντικείµενο 

QObject.  

 Τα γεγονότα (events)  παράγονται από το σύστηµα παραθύρων (window 

system) ή από το Qt ως απάντηση σε διάφορα συµβάντα. Όταν ο χρήστης πιέσει ή 

αφήσει ένα πλήκτρο, παράγεται ένα ανάλογο γεγονός (key event). Όταν ένα 

παράθυρο δηµιουργείται για πρώτη φορά, παράγεται ένα αντίστοιχο  γεγονός (paint 

event) έτσι ώστε το παράθυρο αυτό να σχεδιαστεί.  Τα περισσότερα γεγονότα είναι 

απαντήσεις σε κάποιες ενέργειες του χρήστη, αλλά υπάρχουν και άλλα που 

παράγονται ανεξάρτητα από το σύστηµα. 

 Όταν κάποιος προγραµµατίζει µε το Qt σπάνια χρειάζεται τα γεγονότα, καθώς 

υπάρχει η λειτουργία signals and slots. Τα γεγονότα χρησιµεύουν όταν γράφουµε τα 

δικά µας widget ή όταν θέλουµε να διαµορφώσουµε τη συµπεριφορά των 

υπαρχόντων widget. 

 Τα γεγονότα  χειρίζονται από τους χειριστές γεγονότων (event handlers), οι 

οποίοι είναι εικονικές προστατευµένες µέθοδοι που οι κλάσεις των widget  

υπερβαίνουν όταν χρειάζεται να αντιδράσουν σε ένα γεγονός. Στο Qt τα γεγονότα 

είναι αντικείµενα, που κληρονοµούν από την αφηρηµένη κλάση QEvent, η οποία 

δίνει τη δυνατότητα στο δέκτη ενός γεγονότος ν αποδεχτεί ή να αγνοήσει ένα 

γεγονός.   

 
Σχήµα 3.3 : Τα γεγονότα που προκαλεί ο χρήστης περνούν µέσα από το αντικείµενο QApplication πριν 

φτάσουν στα widgets και πριν σταλθούν τα διάφορα σήµατα.  

 

 Ένα πολύ ισχυρό συστατικό του µοντέλου γεγονότων του Qt, είναι το ότι ένα 
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αντικείµενο QObject  µπορεί να τεθεί ώστε να παρακολουθεί τα γεγονότα ενός άλλου 

αντικειµένου QObject πριν το τελευταίο τα δει. Μια εφαρµογή της παραπάνω 

δυνατότητας είναι να υλοποιήσουµε την απαιτούµενη συµπεριφορά ενός 

αντικειµένου για τα γεγονότα των παιδιών του, που µας ενδιαφέρουν. Αυτή η 

συµπεριφορά µπορεί να επιτευχθεί µε την χρήση των φίλτρων γεγονότων(event 

filters), τα οποία εγκαθίστανται σε δυο βήµατα. Αρχικά συγχρονίζουµε το αντικείµενο 

παρατηρητή µε το παρατηρούµενο αντικείµενο καλώντας την µέθοδο 

installEventFilter() στο παρατηρούµενο αντικείµενο και στη δεύτερον 

αντιµετωπίζουµε τα γεγονότα του παρατηρούµενου αντικειµένου µε την µέθοδο 

eventFilter() του αντικειµένου παρατηρητή. [19] 

3.1.5 Qt Designer 
 

Το Qt Designer είναι ένα εργαλείο ανάπτυξης GUI, που επιτρέπει ταχεία και 

αποτελεσµατική ανάπτυξη διεπαφών για όλες τις υποστηριζόµενες πλατφόρµες 

(Windows, Linux, MacOS). ∆ίνει τη δυνατότητα σε ένα προγραµµατιστή να 

σχεδιάσει και να κατασκευάσει widgets και παράθυρα διαλόγου χρησιµοποιώντας 

φόρµες και widgets on-screen. Τα στοιχεία, που φτιάχνονται µε το Qt Designer 

µπορούν να εκµεταλλευτούν τη λειτουργία signals and slots του Qt και µπορεί 

κάποιος να έχει οποιαδήποτε στιγµή εικόνα για το πώς είναι το στοιχείο που 

κατασκευάζει. [19] 
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Σχήµα 3.4: Το γραφικό περιβάλλον του Qt Designer 

3.2  Η εφαρµογή QSPECT 
 

 Σε αυτή την ενότητα θα αναλύσουµε  την εφαρµογή, που αναπτύξαµε σε 

αυτήν την διπλωµατική εργασία. Η εφαρµογή αυτή δέχεται δεδοµένα που έχουν 

προέλθει από τοµογραφία SPECT ενός αντικειµένου, στην περίπτωσή µας κάποιο 

µέρος από ανθρώπινο σώµατος, και στόχος της είναι να ανακατασκευάζει τις τοµές 

και να παράγει εικόνες σε κάποιο δηµόσιο format (εδώ .bmp) και να τα εξάγει σε 

αρχείο txt.   

 Η εφαρµογή χωρίζεται σε 2 µέρη. Το πρώτο µέρος περιλαµβάνει τις 

λειτουργίες, που είναι σχετικές µε την ανακατασκευή της τοµής από τα SPECT 

δεδοµένα, δηλαδή την κατασκευή του πίνακα πιθανοτήτων, την δηµιουργία του 

αρχείου ανακατασκευής της τοµής από  το ηµιτονόγραµµα (sinogram) µε επιλογή 

ανάµεσα σε 2 αλγορίθµους ανακατασκευής και την παραγωγή της εικόνας από το 

προηγούµενο αρχείο ανακατασκευής. Το δεύτερο µέρος είναι ένας χώρος, όπου 

κάποιος µπορεί να ανοίξει ήδη κατασκευασµένες εικόνες και να κάνει κάποιες 

βασικές ενέργειες, όπως zoom κλπ.       
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 Επίσης θα πρέπει να σηµειώσουµε ότι το λογισµικό έχει δοκιµαστεί και τρέχει 

τόσο σε Windows όσο και σε Linux, καθώς έχει δηµιουργηθεί µε το  Qt που είναι 

cross-platform εργαλείο. 

Σχήµα 3.5 : Το πρόγραµµα QSPECT  σε  Linux. 

 

 
Σχήµα 3.6 : Το πρόγραµµα QSPECT  σε  Windows XP. 
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3.2.1 ∆οµή της εφαρµογής QSPECT 
 

Όπως είπαµε και παραπάνω το QSPECT αποτελείται από δυο µέρη, ένα µέρος 

µε τις λειτουργίες που µπορεί να κάνει και ένα µέρος µε τον χώρο όπου ο χρήστης 

µπορεί να προβάλλει εικόνες και να τις επεξεργαστεί σε ένα µικρό βαθµό.  

Η κύρια κλάση της εφαρµογής είναι η simplewin, η οποία κληρονοµεί από την 

κλάση του Qt, QMainWindow . Η κλάση QMainWindow παρέχει ένα παράθυρο για 

γενικές εφαρµογές µε µπάρες µενού, εργαλείων, κατάστασης, dock widgets γύρω από 

ένα κεντρικό widget, που µπορεί να είναι περιοχή κειµένου, ζωγραφικής κλπ.. Στην 

περίπτωσή µας, η κλάση simplewin περιέχει ως  µέλη όλες τις απαιτούµενες κλάσεις 

και µεθόδους για τις λειτουργίες του προγράµµατος. Ακολουθούν οι δηλώσεις στο 

header file simplewin.h.  

class simplewin : public QMainWindow 
{ 
    Q_OBJECT 
public: 
    simplewin(); 
 bool eventFilter(QObject *target, QEvent *event); 
 
Όταν ο χρήστης ανοίξει κάποιες εικόνες µε το πρόγραµµα, οι προεπισκοπήσεις αυτών 

των εικόνων φαίνονται στο αριστερό µέρος του κύριου widget. Αυτές οι 

προεπισκοπήσεις (preview) µπορούν να έχουν µέγιστο µέγεθος 140 x 140 pixels, έτσι 

αν µια εικόνα είναι µεγαλύτερη δεν φαίνεται ολόκληρη. Στην περίπτωση αυτή, αν ο 

χρήστης πατήσει διπλό click πάνω σε µια από αυτές τις προεπισκοπήσεις, η 

αντίστοιχη εικόνα φορτώνεται σε πραγµατικό µέγεθος στο δεξιό µέρος του 

προγράµµατος, όπου χρήστης  µπορεί να την µεγαλώσει, να την µικρύνει, να της 

δώσει µια χρωµατική απόχρωση ή να την κάνει χρωµατιστή αν αυτή είναι 

ασπρόµαυρη. Με την συνάρτηση  eventFilter ελέγχουµε την συµπεριφορά ενός 

αντικειµένου simplewin, στην περίπτωση που ο χρήστης πατήσει διπλό click πάνω σε 

µια προεπισκόπηση(preview) εικόνας.  
 
 
private slots: 
 void open(); 
 void open(QStringList slist); 
 void print(); 
 void save(); 
 void imgdelete(); 
 void zoomIn(); 
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 void zoomOut(); 
 void normalSize(); 
 void setcolor(); 
 void multicolor(); 
 void fitToWindow(); 
 void Pij_Fill(); 
 void twoDM();  
 void CreateImage(); 
 void about(); 
 

Οι µέθοδοι slots ενεργοποιούνται όταν εκπεµφθεί ένα σήµα που έχει οριστεί να τις 

ενεργοποιεί. Για παράδειγµα η µέθοδος about() ενεργοποιείται όταν ο χρήστης 

πατήσει από την µπάρα εργαλείων την επιλογή Help->about.     
 
private: 
    void createActions(); 
    void createMenus(); 
    void createToolBars(); 
 void createPreviewGroupBox(); 
 void createImagesGroupBox(); 
 
 
Οι παραπάνω 5 µέθοδοι κατασκευάζουν το γραφικό περιβάλλον του προγράµµατος 

και καλούνται µια φορά στην αρχή του κατασκευαστή simplewin(). Η createActions() 

δηµιουργεί τις ενέργειες  µπορούν να γίνουν όταν ο χρήστης έχει κάποιου είδους 

αλληλεπίδραση µε αυτό (π.χ. πατά ένα κουµπί ή κάνει µια επιλογή µέσα από ένα 

µενού). Οι ενέργειες αυτές ανήκουν σε µια κλάση του Qt, την QAction, η οποία 

παρέχει ένα αφηρηµένο user interface για κάποια ενέργεια και µπορεί να εισαχθεί σε 

widgets. Γενικώς στις διάφορες εφαρµογές κάποιες κοινές εντολές µπορεί να 

καλούνται µέσα από µενού, µπάρες εργαλείων, συντοµεύσεις µέσα από το 

πληκτρολόγιο (π.χ. σε µια εφαρµογή συνήθως υπάρχουν µια επιλογή στο menu, ένα 

κουµπί και µια συντόµευση πληκτρολογίου για το άνοιγµα ενός αρχείου). Από τη 

στιγµή που ο χρήστης θέλει αυτές οι εντολές να πραγµατοποιούνται µε τον ίδιο τρόπο 

είναι χρήσιµο κάθε τέτοια εντολή να αντιπροσωπεύεται ως µια ενέργεια, που θα 

µπορεί να προστεθεί σε µενού και µπάρες εργαλείων και να τα συγχρονίσει. Στην 

εφαρµογή µας τα διάφορα µενού και γραµµές εργαλείων καθώς και η πρόσθεση των 

ενεργειών σε αυτά γίνεται µε τις µεθόδους createMenus(),  createToolBars(). Οι  

µέθοδοι   createPreviewGroupBox() και   createImagesGroupBox() κατασκευάζουν 

δυο groupbox (συλλογές από widgets) για την απεικόνιση των προεπισκοπήσεων των 

εικόνων και των εικόνων που φορτώνει ο χρήστης αντίστοιχα.  
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 void updateActions(); 
 void scaleImage(double factor); 
 void adjustScrollBar(QScrollBar *scrollBar, double factor); 
 
    QMenu *fileMenu; 
    QMenu *toolsMenu; 
    QMenu *helpMenu; 
 QMenu *viewMenu; 
 
    QToolBar *fileToolBar; 
    QToolBar *editToolBar; 
 QToolBar *zoomToolBar; 
 
 QAction *openAct; 
 QAction *printAct; 
 QAction *saveAct; 
 QAction *deleteAct; 
 QAction *zoomInAct; 
 QAction *zoomOutAct; 
 QAction *normalSizeAct; 
 QAction *fitToWindowAct; 
 QAction *setColorAct; 
 QAction *multiColorAct; 
    QAction *exitAction; 
    QAction *aboutAction; 
    QAction *PijAction; 
    QAction *twoDMAction; 
 QAction *CreateImageAction; 
    QAction *aboutQtAction; 
 
 QWidget *centralWidget; 
 
 QList<PijWizard *> *pijList; 
 int countpij; 
 QList<twoDLWizard *> *twoDLList; 
 int counttwoDL; 
 QList<PicWizard *> *PicList; 
 int countPic; 
 
 QGroupBox *previewGroupBox; 
 IconPreviewArea *previewArea; 
 QScrollArea *previewscrollArea; 
 
 QGroupBox *imagesGroupBox; 
 QList<double> process_line; 
 QLabel *label; 
 QScrollArea *scrollArea; 
 double scaleFactor; 
 
    QPrinter printer; 
 
 QImage *image; 
 QImage *newimage; 
 QString imgpath; 
 int pindex; 
 
 QVector<QRgb> colors; 

}; 

Ένα σηµαντικό σηµείο του προγράµµατος είναι η εφαρµογή οδηγών 
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(wizards), έτσι ώστε η εκτέλεση κάποιων λειτουργιών από τον χρήστη να είναι 

ευκολότερη. Σε αυτό το σηµείο θα ήταν ενδιαφέρον να αναφέρουµε µερικά στοιχεία 

για την κατασκευή του οδηγού (wizard). Ένας οδηγός είναι ένας ειδικός τύπος 

παραθύρου διαλόγου για είσοδο δεδοµένων (input dialog window), αποτελείται από 

µια σειρά από σελίδες και σκοπός του είναι να οδηγήσει το χρήστη µέσα από µια 

διαδικασία βήµα-βήµα. Η κλάση QtWizard κληρονοµεί από τη γενικότερη κλάση του 

Qt QDialog και κάθε σελίδα ανήκει στην κλάση QtWizardPage.  Κάθε στιγµή µόνο 

µια σελίδα προβάλλεται στον οδηγό και κάθε σελίδα έχει τα ακόλουθα 

χαρακτηριστικά, τα οποία αποδίδονται από τη κλάση QtWizard : ένα τίτλο, ένα 

υπότιτλο και ένα σύνολο από χώρους για εικόνες (pixmaps), οι οποίοι 

χρησιµοποιούνται ή όχι ανάλογα  µε το στυλ που έχει επιλεγεί. Το παρακάτω σχήµα 

δείχνει την απόδοση αυτών των χαρακτηριστικών σε µια σελίδα µε Modern style. 

 

Σχ.3.8:Τα χαρακτηριστικά (attributes) της κλάσης QtWizardPage όπως αποδίδονται στην κλάση 
QWizard σε Modern Style. 

 
 
 Μπορούµε να εισάγουµε µια σελίδα σε έναν οδηγό χρησιµοποιώντας τις 

ακόλουθες µεθόδους της κλάσης QtWizard, QtWizard::addPage() or 

QtWizard::setPage(). Κάθε σελίδα προσφέρει 5 εικονικές µεθόδους, τις οποίες ο 

προγραµµατιστής µπορεί να εφαρµόσει, έτσι ώστε να επεξεργαστεί όπως θέλει τη 

σελίδα: 
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• Η µέθοδος initializePage() καλείται για να αρχικοποιηθούν τα περιεχόµενα 

της σελίδας όταν ο χρήστης πατά το κουµπί Next. Αν θέλουµε να 

διαφοροποιήσουµε τα περιεχόµενα  µιας σελίδας ανάλογα µε το περιεχόµενο 

των προηγούµενων της τότε πρέπει να χρησιµοποιήσουµε αυτή τη µέθοδο. 

• Η µέθοδος cleanupPage() καλείται όταν θέλουµε να καθαρίσουµε τα 

περιεχόµενα µιας σελίδας όταν ο χρήστης πατά το κουµπί Back. 

• Η µέθοδος validatePage() επιβεβαιώνει τη σελίδα όταν ο χρήστης πατά Next ή 

Finish.  

• Η µέθοδος  nextId() επιστρέφει τον αριθµό ID της επόµενης σελίδας. Αυτή 

είναι χρήσιµη όταν κατασκευάζουµε µη γραµµικούς οδηγούς (non-linear 

wizards) και µας επιτρέπει να δηµιουργήσουµε διαφορετικά µονοπάτια της 

ροής του οδηγού ανάλογα µε τις πληροφορίες που δίνει ο χρήστης. 

• Η µέθοδος isComplete() καλείται για να διευκρινιστεί αν τα κουµπιά  Next ή 

Finish πρέπει να µπορούν να πατηθούν ή όχι. 

Σε πολλούς οδηγούς τα περιεχόµενα µιας σελίδας επηρεάζουν τις 

προκαθορισµένες τιµές πεδίων επόµενης σελίδας ή ακόµη χρησιµοποιούνται για τις 

ενέργειες που ακολουθούν την ολοκλήρωση ενός οδηγού. Για την εύκολη επικοινωνία 

µεταξύ σελίδων ένας ειδικός µηχανισµός πεδίων υποστηρίζεται από την κλάση 

QtWizard, που επιτρέπει σε έναν προγραµµατιστή να καταχωρίσει µια τιµή σε ένα 

πεδίο (π.χ. σε µια περιοχή γραµµής QLineEdit) και να την προσπελάσει από 

οποιαδήποτε σελίδα. Τα πεδία αυτά είναι γενικά και έχουν ισχύ σε ολόκληρο τον 

οδηγό και έτσι µια σελίδα µπορεί να έχει πρόσβαση σε αυτά χωρίς να γνωρίζει τη 

λογική που είναι οργανωµένη µια άλλη σελίδα. Τα πεδία που θέλουµε να κάνουµε 

γενικά τα καταχωρούµε µε τη µέθοδο registerField() και τα προσπελαύνουµε µε τις 

field() και setField(). Ως παράδειγµα ακολουθεί η καταχώρηση του περιεχοµένου του 

αντικειµένου fileline, που είναι µια γραµµή κειµένου(Text Line), ως γενικό πεδίο µε 

το όνοµα sourcefilename, έτσι ώστε αυτό να είναι προσβάσιµο από παντού µέσα στον 

οδηγό. Ο αστερίσκος σηµαίνει ότι η συµπλήρωση αυτού του πεδίου από το χρήστη 

είναι υποχρεωτική ώστε να είναι ενεργοποιηµένο το κουµπί Next.  

 

    fileLine = new QLineEdit(this); 
 registerField("sourcefilename*",fileLine ); 
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3.2.2 Οι λειτουργίες του προγράµµατος 
 

 Σε αυτή την ενότητα θα αναλύσουµε τις διάφορες λειτουργίες της εφαρµογής 

QSPECT. Όπως αναφερθήκαµε και προηγουµένως σκοπός αυτής της εφαρµογής είναι 

η ανακατασκευή τοµών από δεδοµένα που προέρχονται από τοµογραφία SPECT. Τα 

δεδοµένα αυτά είναι στη µορφή του ηµιτονογράµµατος για κάθε τοµή. Η 

ανακατασκευή των τοµών γίνεται µε την εφαρµογή ενός επαναληπτικού αλγόριθµου. 

Το πρόγραµµά µας δίνει τη δυνατότητα στο χρήστη να επιλέξει ανάµεσα σε δυο 

επαναληπτικούς αλγόριθµους, τον MLEM και τον  OSEM.   

 

 

• Κατασκευή του πίνακα πιθανοτήτων συστήµατος (system’s probability 

matrix) 

 

Στην κεντρική ιδέα ενός επαναληπτικού αλγορίθµου δίνεται µια αρχική µη 

µηδενική εκτίµηση της εικόνας και σε κάθε επαναληπτικό βήµα η εικόνα 

ανανεώνεται χρησιµοποιώντας τα δεδοµένα προβολής, την εκτίµηση της εικόνας του 

προηγούµενου βήµατος και ένα κανόνα προσδοκώµενης ελάττωσης (expectation 

minimization rule). Το στοιχείο κλειδί σε αυτούς τους αλγορίθµους είναι ο πίνακας 

πιθανοτήτων του συστήµατος, ο οποίος µας παρέχει τις πιθανότητες, που έχει ένα 

φωτόνιο που εκπέµπεται από ένα pixel της άγνωστης εικόνας, να ανιχνευτεί σε 

κάποια περιοχή τoυ ανιχνευτή. Σε αυτόν τον πίνακα πιθανοτήτων λαµβάνεται υπ’ 

όψιν η γεωµετρία του συστήµατος. Επίσης, άλλες φυσικές παράµετροι µπορούν να 

συµπεριληφθουν όπως, η ανταπόκριση της διάταξης παραλληλισµού της 

ακτινοβόλησης (collimators response), η εξασθένηση κλπ..      

Όπως καταλαβαίνει κανείς για την ανακατασκευή της τοµής µε τη βοήθεια 

επαναληπτικών αλγορίθµων απαραίτητη είναι η γνώση του γεωµετρικού πίνακα του 

συστήµατος Ρ (βλ. κεφάλαιο 2). Γι' αυτό το λόγο πρέπει ο χρήστης πρώτα απ' όλα να 

κατασκευάσει το κατάλληλο πίνακα πιθανοτήτων για το σύστηµά του. Η κατασκευή 

αυτού του πίνακα πιθανοτήτων γίνεται µέσω ενός οδηγού και είναι δυνατή η επιλογή 

ανάµεσα σε τρεις διαφορετικούς αλγορίθµους : i) ιδανική διάταξη παραλληλισµού ii) 

µη ιδανική διάταξη παραλληλισµού iii) µη ιδανική διάταξη παραλληλισµού και 
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διακριτοποιηµένος σπινθηριστής (κρύσταλλος).   

i. Είναι η πιο απλή περίπτωση, όπου η περιοχή ανίχνευσης του κάθε 

ανιχνευτή καθορίζεται από δυο παράλληλες γραµµές. Εποµένως η 

απόσταση κάθε pixel από τον ανιχνευτή δεν επηρεάζει τους 

υπολογισµούς. Από τον χρήστη ζητούνται το πλήθος των pixels  ανά 

διάσταση, το πλήθος των ανιχνευτών ανά διάσταση, το πλήθος των 

επιθυµητών προβολών και ο συνολικός αριθµός των γωνιών προς 

ανίχνευση.  

ii. Για την κατασκευή του πίνακα πιθανοτήτων για µη ιδανική διάταξη 

παραλληλισµού χρειαζόµαστε επιπλέον τις εξής παραµέτρους της 

διάταξης : το µήκος της διάταξης και την απόστασή της από το κέντρο 

περιστροφής καθώς και  το πάχος της οπής της διάταξης παραλληλισµού.  

Εδώ πρέπει να σηµειώσουµε ότι κάνουµε την παραδοχή ότι οι οπές της 

διάταξης παραλληλισµού συµπίπτουν τέλεια µε τα pixels του ανιχνευτή. 

Αυτή είναι και η περίπτωση που απαντάται στα κλινικά συστήµατα, όπου 

δεν υπάρχει διακριτοποιηµένος κρύσταλλος. Οι παραπάνω πληροφορίες 

δίνονται από τον χρήστη ως Distance of a detector from the centre of the 

rotation in mm (εδώ περιλαµβάνονται και το µήκος της διάταξης 

παραλληλισµού) και width of a single detector in mm   (είναι ίδια µε το 

πάχος των οπών της διάταξης παραλληλισµού).  

iii. Στην περίπτωση του διακριτοποιηµένου σπινθηριστή (κρυστάλλου, 

pixilated scintillator) η σχετική θέση των οπών της διάταξης 

παραλληλισµού  και των pixels  του κρυστάλλου λαµβάνονται υπ’ όψιν, 

παρόλο που στην πράξη αυτό δεν µπορεί να πραγµατοποιηθεί εύκολα. 

Περιορίζουµε το πρόβληµα στις 2 διαστάσεις για να µπορεί αυτό το 

φαινόµενο να υπολογιστεί γεωµετρικά και να εισαχθεί στον πίνακα 

πιθανοτήτων, δεδοµένου ότι η ανακατασκευή πραγµατοποιείται σε 

διαδοχικές τοµές. Σε τρισδιάστατη ανακατασκευή θα έπρεπε να µελετηθεί 

το φαινόµενο στο χώρο. Στους διακριτοποιηµένους σπινθηριστές συνήθως 

ο αριθµός των Pixels του  κρυστάλλου καθορίζουν το µέγεθος της 

ανακατασκευασµένης εικόνας  και ένα Pixel αντιστοιχεί σε ένα ανιχνευτή. 

Όταν η οπή του συστήµατος παραλληλισµού καλύπτει ένα µέρος ενός 

pixel  ορίζεται ένας  ‘υπό-ανιχνευτής’. Ο χρήστης για την κατασκευή του 
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συγκεκριµένου πίνακα πιθανοτήτων πρέπει να δώσει επιπλέον τις 

παρακάτω πληροφορίες : το πάχος ενός ανιχνευτή, το µήκος, το πάχος  του 

συστήµατος παραλληλισµού και το πάχος των οπών του, τον αριθµό των 

οπών του συστήµατος παραλληλισµού ανά διάσταση, την απόσταση και 

τη σχετική θέση του συστήµατος παραλληλισµού και ενός ανιχνευτή. [11] 

 

Σχ.3.7:Εισαγωγή δεδοµένων από τον χρήστη για την κατασκευή του πίνακα συστήµατος µε την µορφή 
οδηγού(wizard) 

 

Για την κατασκευή του επιθυµητού πίνακα πιθανοτήτων συστήµατος από τον 

χρήστη χρησιµοποιείται ένας αντίστοιχος οδηγός (wizard), για τον οποίο 

δηµιουργήσαµε µια κλάση, PijWizard, η οποία  κληρονοµεί από την κλάση του Qt  

QtWizard. Ο οδηγός αυτός αποτελείται από 4 σελίδες, τις IntroPage, ArrayInfoPage, 

OutputFilesPage, ConclusionPage. Στην πρώτη σελίδα, IntroPage, ο χρήστης επιλέγει 

ποιο αλγόριθµο επιθυµεί να χρησιµοποιήσει . Στην ArrayInfoPage ζητούνται τα 
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απαραίτητα δεδοµένα συστήµατος για τον εκάστοτε αλγόριθµο που έχει επιλεγεί. 

Στην OutputFilesPage ζητείται η διαδροµή στο δίσκο και το όνοµα του αρχείου που 

θα αποθηκευθεί ο πίνακας πιθανοτήτων και εδώ υπάρχει ένα προκαθορισµένο 

(default) όνοµα που σχηµατίζεται από τα στοιχεία που έχουν δοθεί στην προηγούµενη 

σελίδα. Ο χρήστης πρέπει να επιβεβαιώσει τις προηγούµενες ενέργειες  στην 

ConclusionPage για να ξεκινήσει η κατασκευή του πίνακα.   

Οι αλγόριθµοι για την κατασκευή του πίνακα πιθανοτήτων και για τις 3 

περιπτώσεις ήταν υλοποιηµένοι σε γλώσσα C και ήταν αναγκαία η µετατροπή τους σε 

γλώσσα C++ για να ενσωµατωθούν στον κώδικα του γραφικού περιβάλλοντος του 

προγράµµατος. Σε αυτό το σηµείο ίσως θα ήταν ενδιαφέρον να αναφέρουµε κάποια 

στοιχεία αυτής της µετατροπής. 

 Η  C είναι µια γενικής χρήσης διαδικαστική γλώσσα προγραµµατισµού σε 

αντίθεση µε την C++ που είναι µια αντικειµενοστρεφής γλώσσα. Ένα πρόγραµµα σε 

C δεν περιέχει κλάσεις παρά µόνο συναρτήσεις και δοµές. Τα προγράµµατα σε C  που 

υλοποιούσαν τους παραπάνω αλγόριθµους για την κατασκευή του πίνακα 

πιθανοτήτων  ήταν δοµηµένα σε µια συνάρτηση main(). Μέσα στην main() 

πραγµατοποιούνταν όλες οι λειτουργίες για την κατασκευή του πίνακα και την 

εγγραφή του σε ένα αρχείο εγγράφου .txt . Τα προγράµµατα δεν αλληλεπιδρούσαν µε 

τον χρήστη και οι παράµετροι του εκάστοτε πίνακα πιθανοτήτων, που ήθελε ο 

χρήστης να κατασκευάσει, δίνονταν µέσα στον κώδικα και πριν από τη µεταγλώττιση 

του προγράµµατος. Με αυτόν τον τρόπο για την κατασκευή πινάκων µε διαφορετικές 

παραµέτρους έπρεπε  ο χρήστης να αλλάξει τις παραµέτρους µέσα στον κώδικα, να 

µεταγλωττίσει ξανά  τον κώδικα και να τρέξει το πρόγραµµα. Επίσης τα 

προγράµµατα σε C έτρεχαν µέσα από τη γραµµή εντολών.   

Στα πλαίσια της µετατροπής από C σε C++ δηµιουργήσαµε τρεις διαφορετικές 

κλάσεις για κάθε έναν από τους τρεις τρόπους κατασκευής του πίνακα πιθανοτήτων, 

τις οποίες θέσαµε να κληρονοµούν από τη κλάση QWidget του Qt έτσι ώστε να 

µπορούµε να  εκµεταλλευτούµε τις λειτουργίες που παρέχει αυτό το εργαλείο. Οι 

διάφορες παράµετροι(το πλήθος των pixels  ανά διάσταση, το πλήθος των ανιχνευτών 

ανά διάσταση κλπ.)  δηλώθηκαν ως ιδιωτικά µέλη της κλάσης στο αντίστοιχο header 

file. Στον  υπάρχον κώδικα έγιναν κάποιες αλλαγές έτσι ώστε κάποιες συναρτήσεις, 

που χρησιµοποιούνταν,   να µετατραπούν στις αντίστοιχες της C++  και στη συνέχεια 

χωρίσαµε τον κώδικα  σε 4 µέρη. Το πρώτο µέρος υλοποιεί δυο κατασκευαστές για 



 43

την εκάστοτε κλάση, όπου γίνονται κάποιες αρχικοποιήσεις και ανοίγεται το αρχείο 

προς εγγραφή. Επίσης δίνεται στο χρήστη η δυνατότητα να θέσει και να συλλέξει τις 

παραµέτρους για το κάθε είδος πίνακα πιθανοτήτων µέσω αντίστοιχων µεθόδων set 

και get, οι οποίες υλοποιήθηκαν inline. Τα δυο κύρια µέρη του προγράµµατος είναι η 

µέθοδος υπολογισµού του πίνακα πιθανοτήτων µε βάση τις παραµέτρους που έχουν 

δοθεί  και η µέθοδος  εγγραφής του στο αρχείο. Τέλος, σε κάθε µια  από τις τρεις 

κλάσεις  έχουν υλοποιηθεί µέσω του Qt µπάρες προόδου (progress bar) έτσι ώστε να 

δίνεται στο χρήστη η πληροφορία σε ποιο στάδιο βρίσκεται η κατασκευή του πίνακα 

πιθανοτήτων.  

Ακολουθεί ενδεικτικά η δήλωση στο αντίστοιχο header file της κλάση 

Pij_Parallel_NoCollimator_NoDistance, που αντιστοιχεί στην πρώτη περίπτωση.  

 

class Pij_Parallel_NoCollimator_NoDistance: public QWidget 
{ 
 Q_OBJECT 
public: 
 Pij_Parallel_NoCollimator_NoDistance(); 
 Pij_Parallel_NoCollimator_NoDistance(string filename); 
 int File_Write(); 
 void setPixels_Per_Dimension(int 
val){Pixels_Per_Dimension=val;}; 
 void setDetectors_Per_Dimension(int 
val){Detectors_Per_Dimension=val;}; 
 void setNumber_Of_Captures(int val){Number_Of_Captures=val;}; 
 void setDegrees_Of_Captures(int val){Degrees_Of_Captures=val;}; 
 int getPixels_Per_Dimension(){return Pixels_Per_Dimension;}; 
 int getDetectors_Per_Dimension(){return 
Detectors_Per_Dimension;}; 
 int getNumber_Of_Captures(){return Number_Of_Captures;}; 
 int getDegrees_Of_Captures(){return Degrees_Of_Captures;}; 
 
private slots: 
 void cancel(); 
 
private: 
 float Pixel_Area(float Th,long int Detector_Number,long int 
Pixel_Number); 
 int Pixels_Per_Dimension; 
 int Detectors_Per_Dimension; 
 int Number_Of_Captures; 
 int Degrees_Of_Captures; 
 long int All_Detectors; 
 long int Total_Pixels; 
 FILE *arxeio; 
 QProgressDialog *progress; 
 string Filename; 
 

}; 

 



 44

 Η µακροεντολή  Q_OBJECT στην αρχή της κλάσης είναι απαραίτητη για όλες 

τις κλάσεις που χρησιµοποιούν τη λειτουργία του Qt signals and slots. Η κλάση 

διαθέτει δυο κατασκευαστές, έναν που δίνεται το όνοµα του αρχείου που θα 

κατασκευαστεί και έναν που χρησιµοποιείται ένα προκαθορισµένο όνοµα. Στο 

πρόγραµµα µας ο χρήστης δίνει το όνοµα που επιθυµεί να έχει το αρχείο που θα 

κατασκευαστεί. Στη µέθοδο  File_Write() συµπληρώνεται το  αρχείο µε τα δεδοµένα 

που προκύπτουν από τον υπολογισµό µε βάση τις πληροφορίες που έχει δώσει ο 

χρήστης. Ο υπολογισµός αυτός γίνεται στην συνάρτηση  Pixel_Area(float Th,long int 

Detector_Number,long int Pixel_Number) η οποία είναι ιδιωτική και καλείται µέσα  

από την File_Write(). Οι υπόλοιπες συναρτήσεις που ακολουθούν στις δηλώσεις των 

δηµοσίων µεθόδων είναι ειδικές συναρτήσεις για την εισαγωγή(set) ή την 

εξαγωγή(get) πληροφοριών σχετικά µε τις παραµέτρους του συστήµατος , όπως το 

πλήθος των ανιχνευτών ανά διάσταση, και υλοποιούνται inline  στο header file όπως 

βλέπουµε. Αυτές οι µέθοδοι καλούνται από τον οδηγό (wizard) όταν ο χρήστης έχει 

εισάγει τις πληροφορίες του συστήµατος που του ζητούνται και  επιβεβαιώσει την 

κατασκευή του πίνακα. Η συνάρτηση slot  cancel() καλείται όταν ο χρήστης πατήσεις 

το κουµπί cancel στην µπάρα προόδου (progress bar) και η κατασκευή του πίνακα 

ακυρώνεται. Στο πεδίο των ιδιωτικών δηλώσεων δηλώνονται επίσης µεταβλητές που 

αντιστοιχούν στις παραµέτρους του συστήµατος καθώς και διάφορες βοηθητικές 

µεταβλητές.   

 

 Κατασκευή του αρχείου ανακατασκευής µιας τοµής 

 

Για την ανακατασκευή µιας τοµής από δεδοµένα SPECT δίνεται η δυνατότητα 

στο χρήστη να επιλέξει ανάµεσα σε δυο αλγορίθµους ανακατασκευής, τον MLEM 

και τον  OSEM, οι οποίοι και οι δυο είναι επαναληπτικοί αλγόριθµοι. Για την 

εφαρµογή τους είναι αναγκαίος ο πίνακας πιθανοτήτων συστήµατος, τον οποίο 

αναλύσαµε προηγουµένως πως κατασκευάζουµε, και το ηµιτονόγραµµα της 

επιθυµητής τοµής.  

 Όπως έχουµε αναφέρει και στο κεφάλαιο 2 τα κυριότερα  µειονεκτήµατα των 

επαναληπτικών αλγόριθµων είναι οι εκτεταµένοι υπολογισµοί και η µεγάλη χρονική 

διάρκεια της επεξεργασίας.  Όµως, ο αλγόριθµος διατεταγµένων υποσυνόλων 
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(Ordered Subsets Expectation Maximization –OSEM), που βασίζεται στην ίδια ιδέα 

µε τον MLEM,  συγκλίνει πολύ πιο γρήγορα. Η βασική του καινοτοµία είναι ότι 

χωρίζει το σύνολο των προβολών σε υποσύνολα (subsets) και εφαρµόζει τον MLA, 

σε καθένα από αυτά. Για παράδειγµα, χωρίζοντας τα δεδοµένα των προβολών σε 6 

διαδοχικά, µη επικαλυπτόµενα υποσύνολα ο χρόνος ανακατασκευής µειώνεται στο 

1/6, στις ίδιες προγραµµατιστικές συνθήκες. 

 Οι αλγόριθµοι αυτοί ήταν αρχικά αναπτυγµένοι σε γλώσσα C και τους 

µετατρέψαµε σε C++ , όπως κάναµε και για τους αλγορίθµους κατασκευής του 

πίνακα πιθανοτήτων του συστήµατος. Η τεχνική που ακολουθήθηκε είναι η ίδια.  

∆ηµιουργήσαµε δυο κλάσεις για τους δυο αλγορίθµους MLEM και OSEM, την 

twoDMlem120 και την twoDOsem120 αντίστοιχα, οι οποίες κληρονοµούν από την 

κλάση QWidget του Qt και ακολουθήσαµε τα αντίστοιχα βήµατα όπως και για τους 

αλγορίθµους κατασκευής του πίνακα πιθανοτήτων.  

 Ας παρατηρήσουµε λίγο το header file  της κλάσης  twoDMlem120 ως 

παράδειγµα. 

class twoDMlem120 : public QWidget 
{ 
    Q_OBJECT 
public: 
 twoDMlem120(); 
 twoDMlem120(QString pijfilename,QStringList 
sinogramfilename,QStringList savefilename); 
 void init(int Pixels_Per_Dim,int Detectors_Per_Dim,int 
Number_Of_Capt,int Repet); 
 int Pijset(); 
 int ImageRec(); 
private slots: 
 void progresscancel(); 
private: 
 int Pixels_Per_Dimension; 
 int Detectors_Per_Dimension; 
 int Number_Of_Captures; 
 int Repetitions; 
 long int All_Detectors; 
 long int Total_Pixels; 
 float **Sinogram; 
 float *Estimated_Slice; 
 float *Sum1; 
 float *Sum2; 
 float *Pij; 
 float *PijDj; 
 long int *Lines_Of_Pij; 
 long int *Rows_Of_Pij; 
 long int *Number_Of_Nonzero_Pij; 
 long int Nonzero_Pij; 
 long int Counter1; 
 long int Counter2; 
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 long int Counter3; 
 long int k; 
 ifstream  arxeio1; 
 ifstream  arxeio2; 
 ofstream  arxeio3; 
 QProgressDialog *progress; 
 string savefile; 
 QStringList outputfiles; 
 char * pijname; 
 QStringList sinograms;  
}; 

 Από τους δυο παραπάνω κατασκευαστές χρησιµοποιούµε αυτόν, στον οποίο 

τα ονόµατα των αρχείων µε τον πίνακα συστήµατος, το ηµιτονόγραµµα και του 

αρχείου όπου θα αποθηκευθεί η ανακατασκευή της τοµής περνιούνται ως 

παράµετροι. Οι επόµενες τρεις µέθοδοι init(int Pixels_Per_Dim,int 

Detectors_Per_Dim,int Number_Of_Capt,int Repet), Pijset(), ImageRec() είναι το 

κύριο σώµα της κλάσης. Η πρώτη αρχικοποιεί ένα αντικείµενο   twoDMlem120 µε τις 

απαραίτητες παραµέτρους που έχει δώσει ο χρήστης. Η δεύτερη διαβάζει τον πίνακα 

συστήµατος και η τρίτη  εφαρµόζει τον αλγόριθµο ανακατασκευής (εδώ τον MLEM) 

και γράφει το αποτέλεσµα στο αρχείο εξόδου που έχει δοθεί. Η συνάρτηση    

progresscancel() ενεργοποιείται όταν ο χρήστης πατήσει το κουµπί cancel της µπάρας 

προόδου. Οι επόµενες µεταβλητές αφορούν τα στοιχεία που έχει δώσει ο χρήστης 

καθώς   και διάφορα βοηθητικά στοιχεία.   

 Οι παράµετροι που είναι ανάγκη να δώσει ο χρήστης για την ανακατασκευή 

της τοµής µέσω των αλγορίθµων OSEM και MLEM είναι το πλήθος των pixels ανά 

διάσταση, το πλήθος των ανιχνευτών ανά διάσταση, το πλήθος των προβολών και το 

πλήθος των επαναλήψεων που θα γίνουν. Για τον OSEM χρειάζεται να δοθεί ακόµα ο 

αριθµός των υποσυνόλων που θα χωριστούν τα δεδοµένα των προβολών κατά τον 

υπολογισµό  της ανακατασκευής  της τοµής. Οι παραπάνω πληροφορίες καθώς 

επίσης και οι τοποθεσίες όπου βρίσκονται το αρχείο για τον πίνακα συστήµατος και 

το αρχείο µε τις πληροφορίες των προβολών σε µορφή ηµιτονογράµµατος για την 

τοµή που πρόκειται να ανακατασκευαστεί  ζητούνται  από τον χρήστη µέσω ενός 

οδηγού (wizard). Όπως αναφέραµε και για την περίπτωση του πίνακα συστήµατος 

προηγουµένως έτσι και εδώ δηµιουργήσαµε µια κλάση   twoDLWizard µε 3 σελίδες, 

τις   StartPage, SinoInfoPage, FinishPage.   

Στην περίπτωση του οδηγού που χρησιµοποιούµε στο πρόγραµµά µας  για την 

ανακατασκευή µιας τοµής κάνουµε τις παρακάτω δηλώσεις στο header file.    
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class twoDLWizard : public QtWizard 
{ 
    Q_OBJECT 
 
public: 
    twoDLWizard(QWidget *parent = 0); 
    twoDLWizard(const twoDLWizard &pj , QWidget *parent = 0); 
    enum { Page_Intro, Page_Info, Page_Conclusion }; 
    void accept(); 

}; 

∆ηλώνουµε δυο κατασκευαστές εκ των οποίων ο ένας είναι κατασκευαστής 

αντιγραφής (copy constructor) και ο οποίος είναι απαραίτητος να κατασκευαστεί 

επειδή η κλάση κληρονοµεί από την QtWizard. Στο πρόγραµµά µας, ο 

κατασκευαστής αντιγραφής δεν χρησιµοποιείται και στο αρχείο υλοποίησης της 

κλάσης έχει τις ίδιες λειτουργίες µε τον άλλο κατασκευαστή. Η µέθοδος  accept() 

καλείται όταν ο χρήστης πατήσει το κουµπί Finish  και αποδεχτεί τα περιεχόµενα που 

έχει εισάγει στις σελίδες  του οδηγού.  

Στις δηλώσεις  για µια σελίδα του οδηγού  δηλώνουµε τα διάφορα στοιχεία της 

σελίδας όπως περιοχές κειµένου, κουµπιά, ετικέτες κλπ., καθώς και τις διάφορες 

µεθόδους λειτουργικότητας της σελίδας. Ακολουθεί η δήλωση για την σελίδα 

StartPage ως παράδειγµα. 

class StartPage : public QtWizardPage 
{ 
    Q_OBJECT 
 
public: 
    StartPage(QWidget *parent = 0); 
 
protected: 
    void initializePage(); 
 
private slots: 
    void browse(); 
    void browsesino(); 
 
private: 
    QLabel *label; 
    QLabel *labelsino; 
    QLabel *sourcefileLabel; 
    QLineEdit *fileLine; 
    QPushButton *BrowseButton; 
    QLabel *sourcefileLabelsino; 
    QLineEdit *fileLinesino; 
    QPushButton *BrowseButtonsino; 
    QLabel *labelalg; 
    QRadioButton *radio1; 
    QRadioButton *radio2; 
    QVBoxLayout *layout;  
}; 
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Οι συναρτήσεις slot browse() και browsesino() καλούνται όταν ο χρήστης 

πατήσει το κουµπί για την αναζήτηση στο σύστηµα του αρχείου για τον πίνακα 

συστήµατος και του αρχείου για το ηµιτονόγραµµα της τοµής που πρόκειται να 

ανακατασκευαστεί αντίστοιχα.  

Στο αρχείο υλοποίησης (implementation file) της κλάσης  twoDLWizard 

εισάγουµε τις σελίδες  StartPage, SinoInfoPage και FinishPage στον κατασκευαστή 

της κλάσης  

twoDLWizard::twoDLWizard(QWidget *parent) 
    : QtWizard(parent)  
{ 
 
    setPage(Page_Intro, new StartPage); 
    setPage(Page_Info, new SinoInfoPage); 
    setPage(Page_Conclusion, new FinishPage); 
 
    setStartId(Page_Intro); 
 
    
setWindowIcon(QIcon(QString::fromUtf8("C:/thesis/diplo/images/hot/car
diology_128_hot.png"))); 
    setPixmap(QtWizard::BannerPixmap, 
QPixmap("C:/thesis/diplo/images/banner.png")); 
    setPixmap(QtWizard::BackgroundPixmap, 
QPixmap("C:/thesis/diplo/images/background.png")); 
    setWindowTitle(tr("Image Reconstruction file Wizard")); 

} 

και κατασκευάζουµε την µέθοδο accept(), στην οποία παίρνουµε όλες τις 

πληροφορίες που έχει δώσει ο χρήστης στις σελίδες του οδηγού και καλούµε τις 

κατάλληλες συναρτήσεις για την κατασκευή του αρχείου ανακατασκευής της τοµής.  

void twoDLWizard::accept() 
{ 
 QString pijfile = field("sourcefilename").toString(); 
 QString sinofiles = field("sourcefilenamesino").toString(); 
 
Εδώ βλέπουµε τη λειτουργία των γενικών πεδίων field, µέσω των οποίων οι 

επιθυµητές µεταβλητές έχουν ισχύ σε ολόκληρο των οδηγό. Αποθηκεύουµε τις 

γενικές µεταβλητές sourcefilename, sourcefilenamesino  που στη συγκεκριµένη 

περίπτωση πρόκειται για τις τοποθεσίες µέσα στο δίσκο των αρχείων µε τον πίνακα 

συστήµατος και το ηµιτονόγραµµα. 
 
 int siz = sinofiles.size(); 
 sinofiles.remove(siz-1,1); 
 sinofiles.remove(0,1); 
 QStringList sinofile = sinofiles.split(","); 
 QString temp = sinofile.takeFirst(); 
 sinofile.append(temp); 
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Στην τελευταία σελίδα  του οδηγού ο χρήστης επιλέγει αν θέλει να δει τις εικόνες των 

τοµών που θα ανακατασκευαστούν ή αν θέλει να απλώς να αποθηκεύσει το αρχείο 

ανακατασκευής της τοµής ή και τα δυο. Γι αυτό λόγο αυτό υπάρχουν στην τελευταία 

σελίδα δυο check boxes, όπου ο χρήστης µπορεί να κάνει αυτές τις επιλογές. Είναι 

αναγκαίο το περιεχόµενο αυτών των checkboxes να αποθηκευθούν σε γενικά πεδία 

fields, έτσι ώστε να είναι προσβάσιµα από παντού στον οδηγό. Το πεδίο check1 

αφορά το checkbox που ο χρήστης δίνει την πληροφορία αν θέλει να αποθηκεύσει το 

αρχείο ανακατασκευής της τοµής σε ένα αρχείο κειµένου. Αν θέλει να το 

αποθηκεύσει καλείται να δώσει ένα όνοµα, αλλιώς τα περιεχόµενα της 

ανακατασκευής αποθηκεύονται σε ένα προσωρινό αρχείο που µετά το τέλος της 

ανακατασκευής διαγράφεται.   

 
 QStringList outfiles; 
 if(field("check1").toBool()) 
 { 
  for(int i=0; i<sinofile.size() ; i++) 
  { 
   outfiles.append(QFileDialog::getSaveFileName( 
                    this, 
                    "Choose a filename to save the image 
reconstruction file for the \n" 
     +sinofile.at(i), 
                    QDir::currentPath(), 
                    "Images (*.txt)")); 
  } 
 } 
 else  
 { 
  for(int i=0 ; i<sinofile.size() ; i++) 
  { 
   QString t = sinofile.at(i); 
   QStringList h = t.split("."); 
   t.clear(); 
   t = h[0]; 
   t.append("temp."); 
   t.append(h[1]); 
   outfiles << t; 
  } 
 } 
 
Στο παρακάτω τµήµα του κώδικα ελέγχεται ποιος αλγόριθµος έχει επιλεγεί και 

αντίστοιχα δηµιουργείται ένα αντικείµενο της κλάσης  twoDMlem120 ή της 

twoDOsem120, τα οποία στη συνέχεια αρχικοποιούνται µε τις πληροφορίες που έχει 

δώσει ο χρήστης (αυτό γίνεται µε τη βοήθεια των αντίστοιχων γενικών πεδίων) και 

στη συνέχεια διαβάζεται ο πίνακας του συστήµατος µε την  Pijset και 

ανακατασκευάζεται η τοµή µε την ImageRec.  
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 if(field("Mlem").toBool()) 
 { 
  twoDMlem120 *t = new 
twoDMlem120(pijfile,sinofile,outfiles); 
  t->init(field("pixelsperdimension").toInt(), 
   field("detectorsperdimension").toInt(), 
   field("numberofprojections").toInt(), 
   field("repetitions").toInt()); 
  if(t->Pijset()==1) 
  { 
   if(t->ImageRec()==1) 
    QMessageBox::information(this, "Action ok", 
    "The image reconstruction file was 
successfully created!"); 
   else 
    QMessageBox::information(this, "Action 
canceled", 
    "The image reconstruction file creation 
attempt was canceled!"); 
  } 
  else 
   QMessageBox::information(this, "Action canceled", 
   "The image reconstruction file creation attempt was 
canceled!");  
 } 
 else if(field("Osem").toBool()) 
 { 
  twoDOsem120 *t = new 
twoDOsem120(pijfile,sinofile,outfiles); 
  t->init(field("pixelsperdimension").toInt(), 
   field("detectorsperdimension").toInt(), 
   field("numberofprojections").toInt(), 
  
 field("repetitions").toInt(),field("subsets").toInt()); 
  if(t->Pijset()==1) 
  { 
   if(t->ImageRec()==1) 
    QMessageBox::information(this, "Action ok", 
    "The image reconstruction files were 
successfully created!"); 
   else 
    QMessageBox::information(this, "Action 
canceled", 
    "The image reconstruction files creation 
attempt was canceled!"); 
  } 
  else 
   QMessageBox::information(this, "Action canceled", 
   "The image reconstruction files creation attempt 
was canceled!");  
 } 
 
Όταν ο χρήστης θέλει να δει τις εικόνες των τοµών που έχουν ανακατασκευαστεί 

δηµιουργείται ένα αντικείµενο της κλάσης DisplayImages. Η κλάση αυτή δέχεται ως 

ορίσµατα τις τοποθεσίες των αρχείων µε τις ανακατασκευασµένες τοµές, τις 

διαστάσεις τους και µια παράµετρο τύπου bool που δείχνει αν τα αρχεία µορφής .txt 

των ανακατασκευασµένων τοµών θα κρατηθούν ή θα διαγραφούν. Οι εικόνες των 
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ανακατασκευασµένων τοµών προβάλλονται σε ένα ξεχωριστό παράθυρο όπου ο 

χρήστης µπορεί να επιλέξει ποιες θέλει να αποθηκεύσει σε µορφή .png .  
 
 if(field("check").toBool()) 
 { 
  DisplayImages *imgv = new DisplayImages(outfiles, 
   field("pixelsperdimension").toInt(), 
   field("detectorsperdimension").toInt(), 
   !field("check1").toBool()); 
  imgv->show(); 
 } 
 QDialog::close(); 
 this->close(); 
} 

 

Σχ.3.9:Ένα αντικείµενο της κλάσης DisplayImages, µέσω του οποίου προβάλλονται οι εικόνες από τις 
ανακατασκευασµένες τοµές και ο χρήστης µπορεί να επιλέξει ποιες θα αποθηκεύσει. 

 
 

• ∆ηµιουργία της εικόνας της τοµής 

 

Είναι δυνατή η δηµιουργία της εικόνας µιας τοµής από ένα αποθηκευµένο αρχείο 

της ανακατασκευής της. Όταν ανακατασκευάζεται µια εικόνα µε την λειτουργία της 

προηγούµενης ενότητας δηµιουργείται ένα αρχείο κειµένου, όπου αποθηκεύονται οι 

τιµές του κάθε Pixel της ανακατασκευής. Οι τιµές αυτές αντιστοιχούν στους 

υπολογισµούς που γίνονται µε τον αλγόριθµο ανακατασκευής που χρησιµοποιείται 

κάθε φορά και εκφράζουν σε γενικές γραµµές την ποσότητα των εκπεµπόµενων 

φωτονίων. Οι τιµές αυτές όµως δεν µπορούν να αντιστοιχηθούν σε αποχρώσεις του 

γκρι έτσι ώστε να µπορεί η εικόνα να προβληθεί, γιατί περιέχουν και τιµές που 
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ενδέχεται να είναι πολύ µεγάλες ή ακόµα και δεκαδικές τιµές. Επίσης, είναι αναγκαίο 

να γίνει ένα είδος βαθµονόµησης για το κάθε Pixel για να µειώσουµε την εµβέλεια 

των τιµών αυτών και να τις κατατάξουµε στο πεδίο 0-255. 

Οι παραπάνω αναγκαίες ενέργειες γίνονται µέσα από έναν κατάλληλο οδηγό που 

βοηθάει το χρήστη να µετατρέψει ένα αρχείο κειµένου µε τις τιµές των pixel της 

ανακατασκευασµένης τοµής σε αρχείο εικόνας .bmp. Ο οδηγός αυτός,  PicWizard, 

λειτουργεί ανάλογα µε τους 2 προηγούµενους οδηγούς που αναλύσαµε. Ζητά από το 

χρήστη τη διεύθυνση στο δίσκο του αποθηκευµένου αρχείου µε την 

ανακατασκευασµένη τοµή, καθώς και τις διαστάσεις της εικόνας που πρόκειται να 

δηµιουργηθεί. Στη συνέχεια δηµιουργεί την εικόνα και την προβάλλει  και ρωτά τον 

χρήστη αν θέλει να την αποθηκεύσει ή όχι. Πρακτικά, οι ίδιες ενέργειες γίνονται και 

από την κλάση DisplayImages που αναφέρθηκε στην προηγούµενη ενότητα.  

Ακολουθεί το κοµµάτι κώδικα που κάνει τη βαθµονόµηση στις τιµές που 

διαβάζονται από το αρχείο της ανακατασκευασµένης τοµής.  

 QRgb value; 
 QFile file(rootpath); 
 if (!file.open(QIODevice::ReadOnly | QIODevice::Text)) 
  return; 
 double max = 0; 
 double min = 0; 
 QTextStream in(&file); 
 while (!in.atEnd()) { 
  QString line = in.readLine(); 
  QStringList list1 = line.split(" "); 
  for (int w = 0; w < list1.size(); w++) 
  { 
   if(!list1.at(w).isEmpty()) 
   { 
    if(list1.at(w).toDouble()<min) 
     min = list1.at(w).toDouble(); 
    if(list1.at(w).toDouble()>max) 
     max = list1.at(w).toDouble(); 
    process_line<<list1.at(w).toDouble(); 
   } 
  } 
 } 
 
 
Στον παραπάνω βρόγχο while διαβάζονται και εισάγονται σε µια λίστα οι τιµές από 

το αρχείο κειµένου και επίσης βρίσκονται η µέγιστη και η ελάχιστη τιµή. Στη 

συνέχεια στο παρακάτω κοµµάτι κώδικα, γίνεται µια βαθµονόµηση όλων των τιµών 

και αντιστοιχίζονται σε τιµές στο διάστηµα [0,255]. Κάθε τιµή πολλαπλασιάζεται µε 

255 και διαιρείται µε την µέγιστη τιµή που έχει βρεθεί προηγουµένως.   
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 int k=0; 
    QString status = QString("process_line.size = %1 ") 
                        .arg(process_line.size());        
 progress = new QProgressDialog("Creating bmp file ...",0 ,0 
,process_line.size()); 
 progress->setWindowTitle("Progress..."); 
 progress->show(); 
 while( k<process_line.size()){ 
  progress->setValue(k); 
  qApp->processEvents(); 
  for(int i=0;i<image.width();i++) 
   for(int j=0;j<image.height();j++) 
   {  
    double v = (process_line.at(k))*255/max; 
    value = qRgb(v, v, v ); 
    image.setPixel(i,j,value); 
    k++; 
   } 
 } 
 progress->close(); 

 
Σχ.3.10:Ο οδηγός PicWizard δηµιουργεί την εικόνας µιας τοµής από ένα αποθηκευµένο αρχείο της 

ανακατασκευής της 
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ΚΕΦΑΛΑΙΟ  4  

 

ΠΑΡΑ∆ΕΙΓΜΑ ΕΚΤΕΛΕΣΗΣ 
 

 

4.1 Εισαγωγή 
 

Στο κεφάλαιο αυτό θα παρουσιάσουµε ένα παράδειγµα εκτέλεσης των 

λειτουργιών της  εφαρµογής QSPECT. Οι λειτουργίες που θα παρουσιαστούν είναι οι 

εξής : 1) ∆ηµιουργία του πίνακα πιθανοτήτων του συστήµατος, 2) ∆ηµιουργία της 

ανακατασκευής µιας τοµής και εξαγωγή της είτε σε µορφή αρχείου κειµένου .txt είτε 

σε µορφή αρχείου εικόνας .bmp, 3) ∆ηµιουργία αρχείου εικόνας .bmp από αντίστοιχο 

αρχείο κειµένου .txt ανακατασκευασµένης τοµής, 4) Φόρτωµα και προβολή εικόνων.  

 

 
Εικόνα 4.1 : Κεντρικό µενού της εφαρµογής QSPECT σε Windows XP. 
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4.1.1 ∆ηµιουργία του πίνακα πιθανοτήτων του συστήµατος 
 

Μπορούµε να ξεκινήσουµε αυτή τη διαδικασία µε 2 τρόπους, από το µενού 

File επιλογή Create the Probability Matrix ή  πατώντας το πρώτο κουµπί από την 

µπάρα κουµπιών (βλ. τις 2 επόµενες εικόνες).  

 

 
Εικόνα 4.2 

 

 
Εικόνα 4.3 
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 Αφού κάνουµε µια από αυτές τις δυο επιλογές, ξεκινά ένας οδηγός (wizard), 

που βοηθά το χρήστη να κατασκευάσει σε ένα αρχείο κειµένου µορφής .txt το πίνακα 

πιθανοτήτων του συστήµατός του. Στο πρώτο βήµα του wizard  επιλέγεται ένας από 

τους 3 δυνατούς αλγορίθµους κατασκευής του πίνακα συστήµατος, όπως αυτοί 

περιγράφονται στο κεφάλαιο 3. 

 

 

 
Εικόνα 4.4 : Επιλογή του αλγορίθµου κατασκευής του πίνακα πιθανοτήτων του συστήµατος.  

 
  

Στο δεύτερο βήµα ο χρήστης δίνει τις απαιτούµενες πληροφορίες (π.χ. πλήθος 

Pixels ανά διάσταση, αριθµός προβολών κ.α.)  σχετικά µε το σύστηµά του και για το 

οποίο θα κατασκευαστεί ο πίνακας πιθανοτήτων. ∆ιαφορετικές πληροφορίες είναι 

απαραίτητες για διαφορετικούς αλγόριθµους και σε µερικές από αυτές υπάρχουν 

κάποιες συνήθεις τιµές προεπιλεγµένες. Το κουµπί Next ενεργοποιείται µόνο αφού ο 

χρήστης έχει εισάγει όλα τα απαραίτητα δεδοµένα.  
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Εικόνα 4.5 : Εισαγωγή των απαραίτητων πληροφοριών για την κατασκευή του πίνακα συστήµατος  

από το χρήστη. 
 
 

Μετά την εισαγωγή των δεδοµένων του συστήµατος, ο χρήστης καλείται να 

επιλέξει ένα όνοµα µε το οποίο θα αποθηκευτεί σε ένα αρχείο κειµένου µορφής (txt) 

ο πίνακας συστήµατος. Το προεπιλεγµένο όνοµα που δίνεται από το πρόγραµµα είναι 

της µορφής <pij_αριθµός Pixels ανά διάσταση_αριθµός ανιχνευτών ανά 

διάσταση_αριθµός προβολών_σύνολο γωνιών> και αποθηκεύεται στο σηµείο στο 

σκληρό δίσκο όπου υπάρχει και το πρόγραµµα QSPECT. Ο χρήστης µπορεί να 

επιλέξει ένα διαφορετικό όνοµα και τοποθεσία αποθήκευσης πατώντας το κουµπί 

Browse.     
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Εικόνα 4.6 : Επιλογή της τοποθεσίας και του ονόµατος αποθήκευσης του πίνακα πιθανοτήτων.  

 
 Τέλος, ο χρήστης ενεργοποιεί την κατασκευή του πίνακα πατώντας το κουµπί 

Finish στο τελευταίο στάδιο του οδηγού. Η πρόοδος της κατασκευής του πίνακα 

φαίνεται µε µια µπάρα προόδου (Progress bar).   

 
Εικόνα 4.7 : Η πρόοδος στην κατασκευή του πίνακα πιθανοτήτων δείχνεται µε µια αντίστοιχη µπάρα.  
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4.1.2 ∆ηµιουργία της ανακατασκευής µιας τοµής και εξαγωγή της είτε σε 
µορφή αρχείου κειµένου .txt είτε σε µορφή αρχείου εικόνας .bmp 

 

Όπως και στον οδηγό για την κατασκευή του πίνακα συστήµατος έτσι και 

στον οδηγό για την ανακατασκευή µιας τοµής µπορούµε να ξεκινήσουµε την 

διαδικασία είτε από το µενού File->Create an Image Reconstruction File είτε από το 

δεύτερο κουµπί στην µπάρα κουµπιών. 

 

 
Εικόνα 4.8 : Επιλογή «∆ηµιουργία του αρχείου ανακατασκευής µιας τοµής». 

 
 

Ξεκινώντας τον οδηγό ο χρήστης καλείται να δώσει το αρχείο όπου περιέχεται 

ο πίνακας πιθανοτήτων συστήµατος και ο οποίος θα χρησιµοποιηθεί για την 

ανακατασκευή της τοµής καθώς επίσης και το αρχείο µε τα δεδοµένα από την 

τοµογραφία SPECT σε µορφή ηµιτονογράµµατος. Τα αρχεία αυτά πρέπει να είναι σε 

µορφή αρχείου κειµένου .txt. Στο πρώτο στάδιο του οδηγού επιλέγεται επίσης και ο 

επαναληπτικός αλγόριθµος ανακατασκευής που θα χρησιµοποιηθεί και θα είναι ένας 

από τους MLEM και OSEM.     
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Εικόνα 4.9 : Ο χρήστης εισάγει τα αρχεία για τον πίνακα πιθανοτήτων και το ηµιτονόγραµµα της 
τοµής που πρόκειται να ανακατασκευαστεί και επιλέγει µε βάση ποιον αλγόριθµο θα γίνει η 

ανακατασκευή.  
 
 
 

Στη συνέχεια ζητούνται το πλήθος των Pixels ανά διάσταση, των ανιχνευτών 

ανά διάσταση, των προβολών, ο αριθµός των επαναλήψεων που θα πραγµατοποιήσει 

ο επαναληπτικός αλγόριθµος και στην περίπτωση του αλγορίθµου OSEM ο αριθµός 

των υποσυνόλων. Τα δυο πρώτα στοιχεία πρακτικά αντιστοιχούν και στις διαστάσεις 

τις εικόνας που θα παραχθεί (π.χ. 128x128). Το κουµπί Next ενεργοποιείται µόνο αν 

ο χρήστης έχει δώσει όλες τις παραπάνω πληροφορίες.  
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Εικόνα 4.10 : Ζητούνται οι απαραίτητες πληροφορίες ανάλογα µε τον αλγόριθµο που έχει επιλεχθεί. 

 
Στο τελευταίο βήµα του οδηγού ο χρήστης ερωτάται αν θέλει να παραχθεί η 

εικόνα της ανακατασκευασµένης τοµής σε µορφή αρχείου εικόνας .bmp και αν θέλει 

να αποθηκευθεί το αρχείο κειµένου .txt  της ανακατασκευής (βλ. εικόνα 4.11).  

 

 
Εικόνα 4.11 
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Αν από το τελευταίο βήµα του οδηγού έχει επιλεχθεί η εξαγωγή των 

αποτελεσµάτων σε αρχείο εικόνας σε µορφή .bmp εµφανίζεται ένα νέο παράθυρο 

όπου προβάλλεται  η τοµή και ο χρήστης µπορεί να την επιλέξει µε διπλό click και να 

την αποθηκεύσει ως εικόνα. Επίσης, δίνεται η δυνατότητα για πολλαπλή 

ανακατασκευή περισσότερων από µια τοµές κάθε φορά. Σε αυτήν την περίπτωση οι 

τοµές που θα ανακατασκευαστούν πρέπει να έχουν κοινά χαρακτηριστικά, όπως αυτά 

ζητούνται στο βήµα 2 του οδηγού. Πρακτικά οι εικόνες που θα δηµιουργηθούν θα 

πρέπει να έχουν όλες το ίδιο µέγεθος.  

 
 
 
 

 
Εικόνα 4.12: Προβολή µιας τοµής µετά την ανακατασκευή της. 
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4.1.3 ∆ηµιουργία αρχείου εικόνας .bmp από αντίστοιχο αρχείο κειµένου 
.txt ανακατασκευασµένης τοµής 

 

Όταν γίνεται η ανακατασκευή µιας τοµής από τα δεδοµένα SPECT, το αρχείο 

της ανακατασκευής µπορεί να αποθηκευθεί σε ένα αρχείο κειµένου µορφής ,txt όπως 

είδαµε και προηγουµένως. Αυτό το αρχείο κειµένου µπορεί να διαβαστεί κάποια 

άλλη στιγµή από το πρόγραµµα και να παραχθεί η εικόνα της τοµής σε µορφή .bmp.   

Η διαδικασία αυτή ξεκινά από την επιλογή Tools->Create an Image ή πατώντας το 

τρίτο κουµπί στην µπάρα κουµπιών.  

 
 

 
Εικόνα 4.13: Επιλογή «∆ηµιουργία εικόνας» 

 
 

Χρησιµοποιείται και σε αυτήν την περίπτωση ένας απλός οδηγός, όπου 

αρχικά ο χρήστης εισάγει το αρχείο κειµένου από όπου θα διαβαστεί η 

ανακατασκευασµένη τοµή. Στη συνέχεια ζητούνται οι διαστάσεις της προς 

δηµιουργία εικόνας, οι οποίες πρακτικά συµπίπτουν µε τα χαρακτηριστικά Pixels per 

Dimension, Detectors per Dimension , που δώσαµε κατά την ανακατασκευή της 

τοµής από τα δεδοµένα SPECT.    
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Εικόνα 4.14: Εισαγωγή του αρχείου κειµένου της ανακατασκευασµένης τοµής. 

 
 

 
Εικόνα 4.15: Ζητούνται οι διαστάσεις τις προς δηµιουργίας εικόνας. 
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 Μετά τη δηµιουργία της εικόνας, αυτή προβάλλεται και ο χρήστης µπορεί να 

κάνει zoom in ή zoom out και να αποφασίσει αν θέλει να την αποθηκεύσει ή όχι.  

 

 
Εικόνα 4.16: Προβολή της εικόνας, δυνατότητα για  zoom in, zoom out. Ο χρήστης αποφασίζει αν 

θέλει να την αποθηκεύσει ή όχι. 
 

 

Αν επιλεγεί η αποθήκευση της εικόνας τότε η επόµενη σελίδα του οδηγού 

φαίνεται στην εικόνα 4.16 και ο χρήστης καλείται να δώσει ένα όνοµα και µια 

τοποθεσία αποθήκευσης. Αν ο χρήστης δεν επιθυµεί την αποθήκευση της εικόνας, 

τότε ο οδηγός προβάλλει την σελίδα τέλους όπως φαίνεται στην εικόνα 4.17.    
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Εικόνα 4.17: Εισαγωγή  ονόµατος και τοποθεσίας αποθήκευσης. 

 
 

 
Εικόνα 4.18: Σελίδα τέλους του οδηγού. 
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4.1.4 Φόρτωση και προβολή εικόνων 

 

Στην κύρια περιοχή της εφαρµογής QSPECT µπορούν να φορτωθούν και να 

προβληθούν αρχεία εικόνων τύπου .png, .bmp, .jpg . Ο χρήστης µπορεί να ανοίξει µια 

εικόνα ή πολλές µαζί από την επιλογή File->Open Image… . Στη συνέχεια, οι εικόνες 

προβάλλονται στην περιοχή µε τον τίτλο Preview και µε το όνοµα τους πάνω από 

αυτές. Οι εικόνες αυτές έχουν µέγιστο µέγεθος 140x140. Οι ενέργειες αυτές 

φαίνονται στις εικόνες 4.18, 4.19, 4.20.   

 
 

 
Εικόνα 4.19: Άνοιγµα και προβολή εικόνας 
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Εικόνα 4.20 : Μπορούν να ανοιχτούν περισσότερες από µια εικόνες. 

 
 
 

 
Εικόνα 4.21 : Προβολή των εικόνων που επιλέχτηκαν στην περιοχή Preview.  
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 Κάνοντας διπλό αριστερό click σε κάποια από τις εικόνες που έχουµε ανοίξει, 

το πλαίσιο της εικόνας αυτής γίνεται πιο έντονο και η εικόνα φορτώνεται στην 

περιοχή Images. Μπορούµε µεταβάλλουµε τον χώρο που πιάνουν οι περιοχές 

Preview και Images µετακινώντας το κάθετο διαχωριστικό τους δεξιά ή αριστερά. 

Από την στιγµή που µια εικόνα θα φορτωθεί στην περιοχή Images, είναι δυνατές 

κάποιες επιπλέον λειτουργίες. Ο χρήστης µπορεί να µεγαλώσει ή να µικρύνει την 

εικόνα (zoom in, zoom out) κάνοντας click στα κουµπιά µε τα + ή το – αντίστοιχα ή 

από τις επιλογές View->Zoom in , View->Zoom out. Στο µενού View  υπάρχουν 

ακόµα οι επιλογές  Normal Size  και Fit to Window. Η πρώτη επαναφέρει την εικόνα 

στο αρχικό της µέγεθος και η δεύτερη µεγαλώνει ή µικραίνει τόσο την εικόνα ώστε 

να καλύπτει ακριβώς όλη την περιοχή Images.    
 
 

 
Εικόνα 4.22: Η εικόνα µεγαλώνει ή  µικραίνει µε τα αντίστοιχα κουµπιά. 
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Εικόνα 4.23 : Η εικόνα καλύπτει ακριβώς όλη την περιοχή Images τσεκάροντας την επιλογή Fit to 

Window.  
 
 

 Στο µενού Tools µας δίνονται δυο ακόµη δυνατότητες επεξεργασίας της 

εικόνας µε τις επιλογές Set Color και Multi Color Image. Με την πρώτη επιλογή 

µπορούµε να δώσουµε µια χρωµατική απόχρωση στην εικόνα µας. Πατώντας αυτήν 

την επιλογή εµφανίζεται ένα παράθυρο όπου µπορούµε να επιλέξουµε το χρώµα της 

επιθυµητής απόχρωσης (βλ. εικόνες 4.23, 4.24, 4.25) και στη συνέχεια τα Pixels που 

δεν έχουν τιµή µηδέν (η τιµή µηδέν ισοδυναµεί µε µαύρο χρώµα) θα πάρουν τιµές µε 

βάση το χρώµα που επιλέξαµε. Η δεύτερη επιλογή, Multi Color Image, είναι µια 

προσπάθεια να  κάνουµε την εικόνα µιας τοµής έγχρωµη. Τα χρώµατα που 

χρησιµοποιούνται είναι δέκα και ξεκινώντας από το µοβ έως το κόκκινο 

αντιστοιχίζονται σε Pixels µε µικρές τιµές έως Pixels µε µεγάλες τιµές (βλ. εικόνες 

4.26, 4.27) . Όταν γίνει µια από τις δυο παραπάνω αλλαγές σε µια εικόνα, τότε 

ενεργοποιούνται οι επιλογές File->Save Image… και File->Delete Image… . Τέλος, 

όταν κάνουµε δυο συνεχόµενες αλλαγές σε µια εικόνα, π.χ. πρώτα της δίνουµε µια 

χρωµατική απόχρωση και µετά την κάνουµε έγχρωµη, η δεύτερη αλλαγή  θα γίνει µε 

βάση την αρχική εικόνα. Αν θέλουµε η δεύτερη αλλαγή να ενεργήσει πάνω στην 

εικόνα που έχει παραχθεί από την πρώτη αλλαγή, τότε θα πρέπει να αποθηκεύσουµε 

αυτήν την εικόνα και να την ανοίξουµε από το File->Open Image… .         
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Εικόνα 4.24 : Μπορούµε να δώσουµε µια χρωµατική απόχρωση στην επιλεγµένη εικόνα µε την 

επιλογή Tools->Set Color 
 

 
Εικόνα 4.25 : Εµφανίζεται µια παλέτα χρωµάτων για να επιλέξουµε το επιθυµητό χρώµα. 
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Εικόνα 4.26 :Η εικόνα µας σε απόχρωση κίτρινου. Τα Pixels µε τιµές µηδέν εξακολουθούν να έχουν 

µαύρο χρώµα. 
 

 
Εικόνα 4.27 :Μπορούµε να κάνουµε µια εικόνα έγχρωµη µε την επιλογή Tools->Multi Color Image.  
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Εικόνα 4.28 : Τα pixels µε µικρές τιµές έχουν µοβ χρώµα, ενώ αυτές µε τις µεγαλύτερες τιµές κόκκινο. 

 
 

 
Εικόνα 4.29 :Μετά από µια αλλαγή σε µια εικόνα µπορούµε να αποθηκεύσουµε την αλλαγµένη εικόνα.  
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ΚΕΦΑΛΑΙΟ  5  

 

Συµπεράσµατα - Μελλοντικές προοπτικές  
 
 

5.1 Συµπεράσµατα 
 

Σε αυτό το κεφάλαιο θα συνοψίσουµε τα συµπεράσµατα αυτής της εργασίας 

και θα αναφέρουµε µερικές µελλοντικές προοπτικές της. 

• Όπως αναφέρθηκε και σε προηγούµενα κεφάλαια κατά τη διάρκεια της 

διπλωµατικής ήταν αναγκαία η εξοικείωση µε ένα εργαλείο δηµιουργίας 

εφαρµογών µε γραφικό περιβάλλον, όπως είναι το AWT ή το Swing για τη 

γλώσσα Java ή το Qt για τη γλώσσα C++. Η γλώσσα C++ επιλέχθηκε ως η 

γλώσσα, στην οποία αναπτύχθηκε η εφαρµογή µας καθώς ήταν διαθέσιµα τα 

προγράµµατα για τον πίνακα πιθανοτήτων συστήµατος και τους αλγόριθµους 

ανακατασκευής σε γλώσσα C και έτσι η µετατροπή τους σε C++ ήταν 

ευκολότερη. Για την κατασκευή του γραφικού περιβάλλοντος 

χρησιµοποιήθηκε το εργαλείο Qt, το οποίο είναι γνωστό λόγω του πλήθους 

ευρέως χρησιµοποιούµενων εφαρµογών που έχουν αναπτυχθεί µε αυτό όπως  

το γραφικό περιβάλλον εργασίας για σταθµούς UNIX, KDE, ο web browser 

Opera, Google Earth, Skype κ.ά.. Το Qt χρησιµοποιείται κυρίως για συγγραφή 

εφαρµογών ανοικτού κώδικα (open source). Η εξοικείωση µε το Qt έγινε µε 

τη µελέτη συγγραµµάτων και εγχειριδίων και µε την συγγραφή απλούστερων 

εφαρµογών. 

•  Πραγµατοποιήθηκε βιβλιογραφική επισκόπηση της πυρηνικής ιατρικής 

απεικόνισης και ειδικότερα της τοµογραφίας SPECT καθώς και  των µεθόδων 

τοµογραφικής ανακατασκευής. Οι αλγόριθµοι ανακατασκευής που 

χρησιµοποιήθηκαν ήταν οι επαναληπτικοί αλγόριθµοι MLEM και  OSEM. Για 

την κατασκευή του πίνακα πιθανοτήτων συστήµατος , που είναι αναγκαίος για 

την εφαρµογή των επαναληπτικών αλγορίθµων ανακατασκευής, 
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δηµιουργήθηκε η δυνατότητα επιλογής ανάµεσα σε 3 διαφορετικούς 

αλγορίθµους ανάλογα µε τα κατασκευαστικά χαρακτηριστικά του 

συστήµατος.  

• Οι αλγόριθµοι ανακατασκευής καθώς και οι αλγόριθµοι κατασκευής του 

πίνακα πιθανοτήτων ήταν διαθέσιµοι σε κώδικα  C και για το λόγο αυτό 

εργαστήκαµε πάνω στην µετατροπή τους σε κώδικα C++  και την σύνδεσή 

τους µε το γραφικό περιβάλλον, που αναπτύχθηκε µε το Qt.  

• Για να είναι ευκολότερη η διαδικασία ανακατασκευής µια τοµής SPECT  για 

τον χρήστη, χρησιµοποιήσαµε wizards για τύπου βήµα-βήµα διαδικασίες. Το 

ίδιο µοντέλο χρησιµοποιήσαµε για την κατασκευή του πίνακα πιθανοτήτων 

του συστήµατος και  την κατασκευή ενός αρχείου εικόνας από ένα αρχείο 

ανακατασκευασµένης τοµής. 

• Η ορθή λειτουργία της εφαρµογής και των αλγορίθµων ανακατασκευής 

δοκιµάστηκε χρησιµοποιώντας  κλινικά δεδοµένα, τα οποία παρήχθησαν από 

SPECT/CT camera Varicam, του οίκου GE Medical από την κλινική Charite 

Verichow του Βερολίνου.  

 

 

5.2 Μελλοντικές προοπτικές 
 

Στην εργασία αυτή έγινε µια πρώτη προσπάθεια για την ανάπτυξη λογισµικού 

µε γραφικό περιβάλλον  για την ανακατασκευή τοµών από δεδοµένα SPECT , έτσι 

ώστε να είναι φιλικό προς το χρήστη. Ακολουθούν κάποιες πιθανές µελλοντικές 

προοπτικές.  

• Βελτιστοποίηση του κώδικα, τόσο του γραφικού περιβάλλοντος όσο και των 

αλγορίθµων ανακατασκευής ώστε η κάθε λειτουργία να γίνεται 

γρηγορότερα και µε αποτελεσµατικότερο τρόπο. Για παράδειγµα, όσον 

αφορά τη λειτουργία του γραφικού περιβάλλοντος και την επικοινωνία του 

λογισµικού µε το χρήστη θα µπορούσαν να χρησιµοποιηθούν 

πολυνηµατικές τεχνικές (multi threads techniques).  

• ∆ηµοσιοποίηση της εφαρµογής στο διαδίκτυο ως δωρεάν εφαρµογής 

ανοικτού κώδικα. Ο επισκέπτης της σελίδας θα µπορεί να «κατεβάσει» 
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(download) την εφαρµογή στον προσωπικό του υπολογιστή µαζί ίσως µε 

κάποια παραδείγµατα εκτέλεσης και οδηγίες. 

• Ενσωµάτωση περισσότερων λειτουργιών. Θα µπορούσαν να ενσωµατωθούν 

άλλα είδη αλγορίθµων ανακατασκευής καθώς επίσης και δυνατότητα 

διόρθωσης της απόσβεσης των φωτονίων. Ακόµα θα ήταν χρήσιµο να 

ενσωµατωθούν κάποιες περισσότερες λειτουργίες επεξεργασίας εικόνας, 

έτσι ώστε  η εφαρµογή να γίνει πιο αυτόνοµη όσον αφορά την επεξεργασία 

των εικόνων των τοµών.    
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